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1 Introduction

Welcome to Pazzles Mini Creative Cutter!

Congratulations on your purchase of the Pazzles Mini Creative Cutter and on your move to a
more powerful and creative level of scrapbooking! With the Pazzles Mini Creative Cutter and
software, all scrapbookers can make cuts and use techniques that once were available only from
professional diecutters. This computer-driven blade-cut system puts production of custom cuts
in your hands, without the added costs (often totaling hundreds of dollars) for dies.

To get the most of your cutter, we recommend you spend a few moments becoming acquainted
with the cutter, the Pazzles Creative Cutter software, and the supplemental Creative Cutter
learning aids.

Viewing the Creative Cutter Basics Video

The Creative Cutter Basics video provides quick and clear instructions on installing, setting up,
and using the Creative Cutter. Keep it in a safe place for easy reference if you need to reinstall
your product later on.

Using This Book

Keep this manual handy as you explore the possibilities with the Pazzles Mini Creative Cutter.
We recommend that you skim through it to get an idea of what it contains and then follow the
recommended reading sequence on page 2.

Creative Cutter MINI 1



Chapter 1

Introduction

Recommended Reading Sequence

If you’re very comfortable with Windows® software applications and basic printer
operation, use Chapter 2 to properly install and set up the Pazzles Mini Creative Cutter. Skim
through Chapter 3 and 6. To get the most from the cutter, work through the projects in Chapter
4. Finally, review the contents of the remaining chapters to acquaint yourself with the
techniques you can begin incorporating into your scrapbooking projects.

If you’re more confident in your scrapbooking skills than you are with a computer, we
recommend you carefully read Chapters 2 and 3 first. Then work through all the projects in
Chapter 4.

*  Chapter 2 will guide you through proper installation and set up of the Pazzles Creative Cutter.
*  Chapter 3 provides concise instructions on starting the cutter, using the software, and making cuts.

*  Chapter 4 leads you directly through your first projects! In just a few hours, you will master the
techniques you'll use the most often with the Pazzles Creative Cutter.

When you are comfortable with the techniques in the early Chapters of the book, begin to
explore the scrapbooking techniques described in Chapter 5 and beyond.

Sharing Tips and Ideas

The folks who use the Pazzles Creative Cutter are enthusiastic, knowledgeable, and love to
share tips and ideas! To join the discussions, get tips and suggestions from other scrapbookers,
learn about new products, and obtain free fonts and images, visit our website at
www.pazzles.com.

Contacting Customer Support

Your Pazzles Mini Creative Cutter comes with the following support packages, based on which
package you have purchased:

* Basic: 30 days unlimited phone support (866-729-9537) from date of shipping.
* Standard: 6 months of unlimited phone support (866-729-9537) from date of shipping.
*  Premium: 1 year of unlimited phone support (866-729-9537) from date of shipping.

Following that period, Pazzles provides one year unlimited online support from the Creative
Cutter support team at www.pazzles.com. After those periods, technical support is available
from 9:00 am to 3:00 pm Mountain Time Monday-Friday at a rate of $25.00 per hour. Before
you contact the support team, please complete the following steps.

What To Do Before You Contact the Pazzles Support Team

e Check your hardware. Are all cords and connectors on the cutter and your computer fully plugged
in? Is the cutter connected to the computer?

* If the problem seems to occur with the software, turn off your computer and then restart it. Try the
operation again.

» Read Chapter 8 for troubleshooting tips.

Creative Cutter MINI
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e If the problem is with cutting, check the blade and the mat.

Creative Cutter MINI 3



Chapter 1 Introduction

e If the problem remains after completing these steps, contact Pazzles at www.pazzles.com. Include
the following information in your e-mail:

*  Your name and (if applicable) your company name
*  Your TSID number

* A complete description of the problem and if appropriate, the problem file as an attachment.

4 Creative Cutter MINI
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2 Installation and Setup

Contents of the Creative Cutter Package

Before you begin to install and set up the Mini Creative Cutter, unpack the shipping
package and verify you have all parts and pieces.
e Pazzles Creative Cutter Instruction Manual (this book)

«  THE FOLLOWING CD’S ARE ALL COMBINED ON ONE CD SEE figure 1

Paxizlgs

ANREATIVE CUTTER @
% (©) Pazzles 2005

Mini Basic Additions Cp
tneluoes:
The Basics Tutorial
Sample (mages
Over 600 Images and Paper Piecing
Patterns from the Swap CD Collections

Figure 1
*Creative Cutter “The Basics” Tutorial (CD)
*Sample Images CD
*Paper Piecing Patterns from the Swap CD collection
e Creative Cutter Mini Machine
* USB Cord (1)
e Black Power Cord (1)
* Blade holder with blade properly inserted (1). Black washer is already installed.
e Cutting mat (2)
* Pazzles Cutting and Design Software(CD) (1)
* Software training (CD) (1)
* Set-Up Card

Creative Cutter MINI



Chapter 2 Installation and Setup

Installing the Software

Follow these instructions to successfully install and configure the Pazzles Creative Cutter
software.

Installing and Starting the Software

1 Insert the Pazzles Cutting and Design Software for the Creative Cutter into your CD-ROM.

The installation program should begin automatically. If it does not, open My Computer,
locate the CD Drive and click the program icon.

2 To install the software, click Install Letter 2005.
3 When you are prompted to enter a password, type pazzmini.

4 Leave this CD in until instructed to remove.

Setting Up the Cutter and Installing the USB Driver

Attach the Cutter to the Computer

1 Verify the cutter is placed on a sturdy, flat surface that can withstand the weight of the
cutter.

2 Place the cutter in the mini platform if it was included in the Mini Creative Cutter®
package the you purchased, please read the instructions on the platform prior to installing.

3 Connect the power cord. See figure 2 .

Plug USB Here

Plug Power Here

Figure 2

6 Creative Cutter MINI



Chapter 2 Installation and Setup

Install the USB Driver

1 If a USB/Serial device has been installed on your machine before and the drivers that are
about to be installed are different from those installed already, the original drivers need to be
uninstalled.

2 Using the Purple or Gray USB cord, connect the cutter to your computer. See figure 2 on

page 6.

3 Use the power button to turn on the power to the cutter. See figure 3 .

Figure 3

4 When the Windows Found New Hardware wizard open, select “No, not at this time”, then

Power Light

click Next to proceed with the installation.

5 Follow the figures 4 and 5 when the Windows Found New Hardware wizard comes up.

6 On figure 4, select “No, Not At This Time.”

ound New Hardware Wizard

YWelcome to the Found New
Hardware Wizard
Windows will zearch for current and updated zoftware by

looking on your computer, on the hardware installation C0., or on
the Windows Update \wWeb zite [with pour permizzion).

Eead owr privacy policy

Can wWindows connect to Windows Update to zearch for
software?

() YWes, this time anly
() ez now and every time | connect a device

@i

Click Meust to continue.

Mest > ] [ Carcel ]

Figure 4

Creative Cutter MINI



Chapter 2 Installation and Setup

Found New Hardware Wizard

This wizard helps you install software for:

USB <-= Serial
' ) your hardware came with an installation CD

=) K
&2 orfloppy disk, insert it now.

What do you want the wizard to do?

(@ Install the software automatically (Recommended) )
(7 Install from a list or specific location (Advanced)

Click Mext to continue.

[ < Back “ Meod = ] [ Cancel

Figure 5

7 The progress of the installation is displayed on your screen. When the installation is
complete, click Finish.

_‘*’_ IMPORTANT: You must repeat this process one more time!!!

8 The Windows Found New Hardware wizard will appear again. Follow figure 4 on
page 7and figure 5 on page 8 to complete the process for the second set of drivers.

9 When the last window comes up press Finish again, and installtion is complete. Please
remove the Cutting and Design software for the Creative Cutters at this time. If the drivers did
not properly install, please follow the steps listed below.

A WARNING! ONLY FOLLOW THE STEPS BELOW IF THE ABOVE
STEPS DO NOT INSTALL PROPERLY!!!

1 Press BACK until you reach the page shown in figure 4 on page 7, then Select “No, Not at
this Time”. Then click Next to proceed with the installation.

2  On the window shown in figure 5, select Install from a list or specific location
(Advanced), then click next.

3 Select Search for the best driver in these locations and enter the file path (your CD drive,
most are D) in the combo box. (Example: D:\\ ) OR browse by clicking the browse button and
go to your CD drive. Click Next when finished.

4 The Windows Found New Hardware wizard will appear again. Follow steps 1-3 to
complete the process for the second set of drivers.

NOTE: 1If a warning message about non-WHQL certified driver are about to be installed, click
Continue Anyway to continue with the installation

IMPORTANT: You must repeat this process one more time!!!

8 Creative Cutter MINI



Chapter 2 Installation and Setup

Determine the Port the USB to Serial Was Assigned To

Complete these steps after installing the USB to Serial Converter (See INSTALL THE USB
DRIVER) section if you have not already done so.

1 Go to Start at the bottom-left corner or your screen and click on it.

Find My Computer and RIGHT-click on it. When you do, a menu opens.
Click on Manage.

Click Device Manager.

Click Ports to view a list of ports see figure 6 .

A U1 A W N

From the list of ports, look for a USB Serial Port. Take note of the port number assigned to
it. You will use the port number when setting up the plotter codes in the Cutting Program. If the
number is higher than 6, you must change it using the “Change Port Number” procedure that
follows these instructions.

4+ Device Manager

Fle  Ackion  View Help
m a8 A

o Computer
o Disk drives
@ Display adapters
i DVDJCD-ROM drives
=) Floppy disk controllers
=5 IDE ATAJATART conftroflers
‘e [EEE 1394 Bus host controbers
,&j Infrared devices
= Keyboards
) Mice and other ponting devices
+ ﬁ.. Modems
+ % Morkors
+ EB Network adapbers
* i PCMCIA adapkers
= o Ports {COM & LFT)

P R0 EmE-me

' USE Seriad Port {COMS)
R W

Figure 6

Change the Port Number

Use this procedure if the port number is higher than 6.

1 Double-click on the port to open the Port Properties screen.
2 Click on the Port Settings tab.

3 Click on the Advanced button.

Creative Cutter MINI 9



Chapter 2 Installation and Setup

4 Look for the COM Port Number window.

5 Click the arrow to display available ports. Ports that are unavailable are marked “In Use”.
6 Choose an available port with a number 1, 2, 3, 4, 5, or 6 and click OK.
7

Use the number to set up the cutting in plotter codes under settings in the software. You
may want to write it down for reference so you’ll remember.

Install the USB Security Key (Hardlock)

1 Insert the USB Key (the black key with a green light on one end that says ROCKEY?2 in
white lettering). See Figure 6.

’L"f NOTE: The key can be found in your Cutting And Design software case with the Pazzles
Creative Cutter software CD.

Figure 7

2 This key will install automatically.

c WARNING! This key must be inserted at ALL times when the program is in use! This key
must also be inserted into the SAME USB port on you computer that it was installed on
originally, otherwise you will encounter an error when trying to open or operate the program!

Setting Up the Software

1 Start Pazzles Creative Cutter. To do so, double clicking on the Creative Cutter Icon on
your Desktop. See figure 8 .

Figure 8

2 When the Start Up window (figure 9 ) opens, press the ESC key on your keyboard. The
Welcome screen then opens.

10 Creative Cutter MINI



Chapter 2 Installation and Setup

Press esc key to start WinPCSIGN Letter.

5 Payizles

Cutting & Desgn Sof tasre for your Creative Cutter

Figure 9
3 Click on the image in the left part of the welcome window that appears in Pazzles Creative
Cutter. See figure 10.

Figure 10

4 In the Page box, type the dimensions of the size of paper you plan to cut. For now, type 11
in the Length and 8 in the Height box. Then click OK. The page dimensions you typed are
saved for use in the future, and the Workspace screen opens.

IMPORTANT: The mini uses 11” for the Length and 8” for the Height, See figure 23
on page 23. The page should look like it is in a landscaped orientation on your
computer.

=
=

Configuring Toolbars and Software Settings

1 Click the View menu on the Pazzles Creative Cutter screen, and then click Toolbars. See
figure 11 on page 12. (Toolbar selections determine the toolbars that appear when you open the
program)

Creative Cutter MINI 1
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2 Click each of the following options to select them: Standard bar, Tools bar, Selection
bar, Manipulation bar, Zoom bar. The toolbars you select are marked with a checkmark.

" WinPCSIGN - [WinPCS1 *]

B Fle Edit Craw Text Tocls Bitmap Shape Setfing Window H
D= | 14 v Standard bar ON/OFF
v Tools bar CMNJOFF
J @ Colorpactte ONIOFF |, Selection bar CN/OFF
v Message bar OM/OFF v Manipulation bar  OMN/OFF
|T = v Rules O/OFF Text bar CMNfOFF
ﬂ i v Height and Length  ON/OFF Segment bar ONJOFF
i ] v Time ON/OFF Arc bar CMNfOFF
[illad v Coordinates ON/JOFF Crve bar ON/OFF
e [ v Page OM/OFF Circle bar CMJOFF
2 Construction points  ONOFF Polygonbar  GN/OFF
ke ] Grid OMNJOFF Erase bar CNJOFF
=] | Show printer page  ONJOFF Color bar ONfOFF
| 34 Wire frame OMJOFF Justification bar - QM/OFF
Al ] Marker ONJOFF | w Zoom bar ON/OFF
= Bd
=? 1 Image bar QM/CFF
% 7_: Line-Cote CMNfOFF
— Magic Ruler QM/CFF
E ] Camment CMJOFF
ﬂ Bia Clip art CNJOFF
Register OMNJOFF
4| s Web Bar ONJOFF
@ Reset
l e Default
all ] T
Figure 11

3 From the View menu, click Grid to select it. Turning on Grid is helpful in placing images

by displaying small dots at 1-inch intervals on the Page screen.
4 Click the Settings menu, and then click Grid to open the Setting box.
5 In the Setting box, click the Unit/Page tab.

6 Under Unit of measurement, click inches.

TIP: You can change the Toolbar and Grid settings at any time.

7 Click the Vectorization tab, and then click the Make Clean box to check it.

Setting

[ Apply path onimage

Documerﬂ Save I Unit/Page “ectorization WSnap }

X

Tolerance
Arc Segment
32 30

Clean

P Tolerance

[v hake clean e 3
Feset

oK Cancel Help
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Chapter 2 Installation and Setup

Figure 12

Unless you reinstall the software, you should not need to make further changes to the
Vectorization settings.

Select the Plotter

1 Open Pazzles Creative Cutter.

2 (Click Settings, and then click Plotter Codes. When you do, the Setup Plotter box opens.
3 Click Add/Remove and then select MINI MC270 from the list of Active Plotters.

4 Click Accept/Save.

Select the Port

In the Port box, click COM port and then select the one assigned (see “Determine the Port the
USB to Serial Was Assigned To” on page 9). Try a test cut. (See “Basic Procedures for Using
the Mini Creative Cutter” on page 21.)

" IMPORTANT: Do NOT leave the Creative Cutter Mini on for extended
*° periods of time!!!

"T’f NOTE: When unplugging the Mini, always connect power and then the USB. If using a laptop,
turn off screen savers & sleep mode. This causes the ports to ‘go to sleep’. If this happens you
must unplug and re-plug your cutter back into your computer to re-establish connection.

Working With the Blade

The cutter is delivered with the blade inserted properly into the blade-holder unit.

Characteristics of Properly Installed Blades

Take note of how far the blade is installed in the casing—a properly-installed blade is barely
visible. Use the blade gauge included with the cutter to determine the proper blade length.

See figure 15 on page 16.

Many factors affect the life of your blade.
* The weight of the paper being cut.

*  The composition of the paper being cut.

* The experience of the person doing the cutting. The life of your blade will depend on the
improvements to your technique that come with practice.

Proper adjustment and correct pressure will ensure you derive maximum longevity from your
blade.

Creative Cutter MINI 13
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Replacing the Blade

Blades should be replaced when any of the following conditions occur:
*  Cut quality suddenly gets worse.
*  You must continue to increase pressure to get clean cuts.

*  The corners and tight turns do not cut cleanly or are pushed in.

NOTE: This condition can also be caused by using too much pressure.

Use the following procedure when it is time to replace the blade.

TIP: Be sure to remove the blue cap from the blade before inserting.

1 Loosen the gold adjusting lock nut from the blade casing and then remove the silver
bladeholder from the blade casing. See figure 13 .

Blade Blade Holder Blade  Blade Casing

adjusting lock nut
Black Plunger

Figure 13

2 Insert the blade into the silver holder as far as it will go. To avoid puncturing your skin on
the blade, push the blade with your fingernail.

3 Screw the bladeholder into the black plunger until the blade is barely visible and can barely
be felt. Use the blade positioning guide see figure 15 on page 16 on how to adjust the blade to
the correct length. Because of paper thickness and characteristics of individual machines, you
might need to make minor adjustments.
IMPORTANT: DO NOT ADJUST YOUR BLADE WHEN YOU FIRST RECEIVE
YOUR MACHINE, IT HAS BEEN PRE-SET FOR CARDSTOCK CUTTING!!!

4 Use the blade positioning guide shown in figure 15 on page 16 to check the position of your
blade. Place the blade next to the picture; the blade in the picture and your blade should match.

5 Tighten the gold adjusting lock nut to hold the blade in place.

TIP: Keeping the silver bladeholder still while you tighten the gold adjusting lock nut can take
some practice.

NOTE: The blade only needs to be extended out as thick as your paper is. Over-extending the
blade will casue poor cutting quality and excessive wear on your blade and mat.
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6 Loosen the white thumbscrew on the cutting carriage (figure 14 ). Insert the blade unit into
the opening of the cutting carriage. Loosen to remove blade holder.

Figure 14

7 While supporting the carriage with a finger, push in the bladeholder. When the blade-holder
unit is inserted as far as it will go, tighten the screw

IMPORTANT: Remember to tighten the white thumbscrew after you put the
blade holder back into the carriage.

(B ]
(B ]
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Blade Positioning Guide

Blade Positioning Guide

Blade should be no shorter than the figure on the left
and no longer than the figure on the right.*

*For paper and medium weight cardstock.

Figure 15
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Working With the Cutting Mat

" IMPORTANT: Using a cutting mat beyond its useful life will result in poor-quality cuts.
o0

1 Please take off the clear cover that came on your mat before putting the paper on the mat.
See figure 16

Figure 16

2 Place your paper on the mat inside the blue border, on the sticky part of the mat. See
figure 17 .

Figure 17

3 Smooth your paper on the mat.
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Figure 18

4 Put mat into cutter when you are ready to cut.

Insert the Mat Into the Cutter

5 Insert the mat from the back of the cutter.

6 Turn the paper feed knob located on the left side of the cutter foward to move the mat under
the pinch rod. See figure 19 .

Figure 19

7 See figure 20 , this shows how the mat goes into the cutter. When inserted, the bulk of the
mat should extend out the back of your cutter. See figure 21 on page 19.

Feed Peper From Buck of Cutter

Note! The mat will extend all the way—
across the cutting platform. This is

fEdgC of Cuﬂing MGT' NORMAL for the mat to fill up

the cutting space.

Figure 20
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Figure 21

c WARNING! The tip of your blade holder needs to be in the corner of the paper to make the cut
match the design on your screen.

IMPORTANT: Using a cutting mat beyond its useful life will result in poor-quality cuts.

=
=

How To Tell When You Need a New Mat

*  Your mat is warped, heavily scored or won’t lie flat.
* You have a new blade and your cutting quality is poor overall.
*  Your design cuts fine in some places but not in others.

*  The mat no longer holds paper effectively.

Tips for Getting the Most From Your Cutter Blade and Mat

*  Always store your mat flat and keep it covered with it’s clear covering when not in use.

*  When cared for properly, the adhesive on the cutting mat has a useful life of about 25-50
passes.

* Do not over-extend the blade. You should barely be able to see or feel the blade.

" IMPORTANT: If you see heavy score marks in the adhesive, your blade is out too far or the
oo pressure is too great.

\’}Z’ NOTE: Humidity affects the tackiness on the mat!
" IMPORTANT: Your machine is shipped to you with its blade already properly inserted. Please

oo DO NOT adjust your blade once you receive your machine. We recommend that you become
familiar with your cutter before you attempt to adjust the blade.

Care and Usage Guidelines fro Cutting Mats

* Store the mat flat and covered with its clear protective sheet covering the adhesive.

Creative Cutter MINI 19
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e If oil from your hands gets on the mat, try to remove it with a lint roller or masking tape. How-
ever, if your mat is too tacky, this can help alleviate some of the stickyness.

* Scrape bits of paper off the mat, try to remove it by patting rolled-up packing tape over the
mat, or by using an old credit card.

* Do not cut high fiber papers that can leave fibers on the mat.

* Since the protective cover for the mat is plastic, it will attract dust. When removin the plastic
covers, place it in a dust-free area. If the protective cover does attract dust, wipe it off prior to
recovering the mat for storage.
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3 Basic Procedures for Using
the Mini Creative Cutter

Introducing the Cutting Control Panel

The Cutting Control Panel plays an important role in the success of your cutting projects. It’s
important that you are familiar with the Cutting Control Panel and the settings you will apply to
it. Refer the information in this chapter as you use the cutter. See figure 22.

The Cutting Control Panel

utting control panel

P (Fanci) [—m Tl [ e m I Sendlofie _] m
[” Rotate
Retum
. w I Weedng r Wesdal —‘
vt Tooks Bemap She SLOWER b4

I.engﬂlesngH
] J:ﬂﬁl 4 Options Al colors @ -535 % 559 Slwwwm|
= W

Material: Usually you will leave this a!t 12.000.
*  Pressure: Can be set anywhere from 10-245.
*  Advance: Should not be checked.
Vinyl Size: Shows position of object on page.
Zoom Tools: Allow you to zoom in and out.
*  Color Boxes: Allow you to choose which line color to cut
*  Panels: 101, 102 in this box means your project is too big for the paper.

i

Figure 22
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Settings for the Cutting Control Panel

Material

Set Material to 12.00.

Advance

Leave clear (not checked).

Vinyl Size

Shows the position of the object on the page.

Zoom Tools

Enables zooming in and out while within the cutting mode.

Color Boxes

Enables you to select which line color to cut.

Panels

If 101, 102 appears, indicates that your project is too big for the paper.

Speed

Slow and Medium are the most commonly used speeds.

Pressure

Set between 80 and 245

Positioning Arrows

Allow you to move the mat forward and backward and to move the blade to the left or right.

Starting and Using the Cutter

c CAUTION: Do not leave the cutter powered on for extended periods.
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Chapter 3 Basic Procedures for Using the Mini Creative Cutter

IMPORTANT: Before you begin, verify all software and hardware is installed and configured
correctly. See chapter 2 and the previous section for details.

Step 1: Start the Cutter

1 Turn on cutter by pressing the switch on the right side of the machine. The green light on
top of the machine on the right end-cap will turn from red then green when it is ready to cut.

2 Apply the paper to the mat as shown in “Insert the Mat Into the Cutter” on page 18.

T - <.
Olsl) - Lu18] 813] 4] F) Ao 15| wirisie 8 Aaas =
% -]
|
toy =
y ©
Orientation of page (with word) How same project will cut
on Computer Screen in the Creative Cutter Mini
Figure 23

3 Insert the mat into the cutter from the back. See figure 23 .

4 Use the paper feed knob on the left side of the cutter towards you ( See “Insert the Mat Into
the Cutter” on page 18.).

Step 2: Start the Software

1 Open the Cutting Software (see “Installing and Starting the Software” on page 6).

2 (Click the left-most image on the Welcome screen to open the Sign page box.

Figure 24
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IMPORTANT: TO CUT AN 8 1/2” X 11” PAPER, ENTER 11” FOR LENGTH AND 8”
FOR THE HEIGHT. IT SHOULD APPEAR IN LANDSCAPE ORIENTATION ON YOUR
COMPUTER SCREEN. See figure 23 .

=
=

3 Type the length and height of the paper you are cutting in the appropriate boxes and then
click OK.

4 At the top of the screen, click Draw and then click Circle. When you do, the cursor changes
to a plus sign.

5 In the blank page on your screen, click the cursor about one inch inside and down from the
upper-left corner.

6 Hold down the mouse and drag the cursor to draw a circle about the size of a quarter. Your
screen should look similar to figure 25

" WinPCSIGN - [WinPCS1 *]
H Fle Edt view EBEIM Text Tools Bitmap Shape Setfing Window Help

e | al®] x e | welzlnsles)
Freehand 4

. Rectange b ]
Star
Polygon
Cwval

ArT

] Registration mark. Q
R ——

S
o [
T
IS
&l
1

<

El
|
ik
@y
[
4|
@
Y

3

Figure 25

Step 3: Make the Cut

1 Position the paper onto the mat and load it into the cutter. For test cuts, use lightweight
(65 1b.) cardstock. For detailed instructions on loading the paper, see “Working With the
Cutting Mat” on page 17.

2 At the top of the screen, click the Cut Panel icon to open Cutting Control Panel window.

Text Tools Bitmap

s(2) 4/ 7

Figure 26
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3 On the Cutting Control Panel window, clear the Advance box if it is checked. See
figure 27 .

F‘n_ Panels Material: [12000 [ i [" Selected ohieot [~ Sendto fie Stat
— [" Rotate [ Advance  ryqeais
Pressure; |135 v =) i Retun
mﬂt sl ™ Weedng [~ Wesdal gg8 3

Length » Height

Options Al colors ﬂ . ﬂVinyISize: 78 x 960 Stop cutting

|3

Figure 27

4 On the Cutting Control Panel window, click the Options button to open the Cutting
Options window. See figure 28.

weedvalue: |THE [~ Use spooler

[~ Soncbiects _Cancal_|
Curve resolution : ’57 [ Cutline panel

Pangl overlap: |0 [~ Save material
[v Start point orientation
Knife Offset 14 £

Feeding material
[ Antiblock when unrool materiel

1 B84 6 7 1234567849
Speed pen UP SpeedFD
Engraving
Depth ZDown T
’7 Wi'ark ’7 ,7
5 Surface 20 l 2UP: ) a3 ||
Down o ZUP

y vy T e —

Figure 28
5 Set the Cutting Options to match those shown in figure 28.

6 Verify that the mat is positioned in the cutter properly, refer to “Working With the Cutting
Mat” on page 17.

7 Verify that the blade carriage is at the right side of the cutter and the green light is on.
8 Set the pressure to 145, and the cut speed to SLOW.

9 On the Cutting Control Panel, click Start to initiate the cut. If cutting does not start, see
“Select the Plotter” on page 13.

10 Examine results; continue to test various pressures until the cut is satisfactory. For more
information, see “Tips for Determining Proper Pressure to Assure Clean Cuts” on page 27.

L’,y NOTE: If your cutter’s blade carriage goes to the left side of the cutter and just sits, your page
may be set wrong. Please see “Change the Page Size” on page 26.
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26

=
=

Change the Page Size

1 Click Setting from the menu bar at the top of the screen.
o

B File Edit View Draw Text Tools Bitmap ShapeQeiryWindow Help

2 From the Setting menu, click Page. See figure 29.

1ape Window Help
(_]| Brush /Pen «:?
Setup
Line guides
— Snap ——
Grid
Page
Unit
Plotter codes

v Powerful computer  ON/fOFF

Figure 29
3 Change the page size to 11x8. See figure 30.

4 Click OK.
ettie__________________B
Document] Save Unit/Page IVectorization] Shap ]

Uit of measurement Sign page

w11

" cm &+ inches
 poinks 7 picas

© pimels O mm

0.000 -
Uze the page justification fonction on
f* Sign i Printer

TrueType font height

f* LUpper caze " Upper/Lower caze
Feset
ak | Cancel £ Help
Figure 30

IMPORTANT: YOUR PAGE MUST LOOK LIKE IT IS IN LANDSCAPE ORIENTATION IN
ORDER TO CUT!
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Tips for Determining Proper Pressure to Assure Clean Cuts

The way the blade is inserted in the blade holder, various types of papers, and differences in
humidity and blade length can all affect the pressure required for a good cut. Although the
pressure setting is usually between 80 and 165, it can go as high as 245. Use these tips to
determine the pressure needed for successful cutting.

*  You must test for proper pressure each time you replace the blade.
*  Pressure is too high if the blade deeply scores the mat or if the paper bunches up and tears.
e Pressure is too low if the paper does not cut completely.

e If you are cutting 65 Ib. paper and require pressure under 120 for a good cut, it is possible that the
blade is out too far. Reinsert the blade so that it is barely visible and can barely be felt, and then
increase the pressure.

*  Once you determine a good pressure for 65 Ib. (light cardstock) paper, use that pressure as a
baseline for other types of papers. For example, if a pressure of 140 works well for 65 Ib. (light
cardstock) try 90-100 for text-weight paper and 185-200 for heavy-weight paper. Refer to the list of
pressures to use with each machine that is included in your paper pack, or call and request a copy.If the
start and stop points do not meet, try changing the knife offset to 12 or 13.

*  You will develop a “feel” for the right pressure with experience. Don’t be afraid to experiment to
see what works best.

Changing the Position of the Paper and Blade Carriage

You can move the mat forward or backward and you can move the blade carriage left or right to
adjust the cutting start point. These buttons are located in the Cutting Control Panel. See
figure 31 . on page 27.

Move Blade

Left
A
Move Blade Yenmommnn Move Blade
to Frontof 4 » I to Back of
Project - Project
Move Blade
Right

Figure 31 .

Adjusting the Blade Carriage

1 Press the left arrow to move the blade to the front of the project.

2 Press the right arrow to move the blade to the back of the project.
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3 Press the up and down arrows to move the blade left or right.

Fixing Problems that Occur During Cutting

28

A

\

4

WARNING! 1If you experience a problem, do not yank the paper out and do not force the
carriage to move. If necessary, turn off the cutter to remove the paper and move the carriage.

For more troubleshooting techniques, see “Troubleshooting Guide” on page 127.

Canceling a Cutting Job

If something goes wrong while you are cutting, use the following procedure to cancel the
cutting job and start again.

e Press stop cutting on the Cutting Control Panel.
e Turn the power to the cutter off by pressing the power button.
e Turn the power back on by using the power button, the carriage will move back to the start

position when the power light (green LED) is turned back on.

NOTE: Your computer spools the cut job to the cutter (much like a printer) so quickly it may
not stop cutting when the stop cutting button is pressed.

Cutter Starts to Cut Poorly

If the cutter was working fine and then seems unable to cut through paper, try these procedures:
*  Clean the mat. Scrape off any bits of paper and remove bits of lint.

* Increase the pressure setting. Pressure can be set as high as 245. See “Tips for Determining Proper
Pressure to Assure Clean Cuts” on page 27.

* Try reducing the pressure. Using too much pressure can cause poor cuts, especially in tight
corners.

e Press down several times on the silver tip of the blade holder. Do this while the blade is inserted in
the carriage. Sometimes a minuscule piece of paper or dust can keep the mechanism from moving
freely.

e Check for debris around the blade itself.

* Re-insert the blade. Blades occasionally move a slight bit in the blade holder, and even the tiniest
change can affect pressure.

*  Are the cutter platforms installed? The platforms prevent the mat from drooping which will cause
poor cutting especially at the edges of the mat. If you purchased the Creative Cutter® Mini Basic
Package, a platform was not included and may need to be purchased.

*  Replace the mat. It might be warped or have too many layers of adhesive.
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* Replace the blade. It might be worn from use, it might be damaged from a paper jam or from
cutting heavy or unusual material, or it might be defective.

e Restart the cutter.

* Restart the program.

c CAUTION: Do not leave the cutter powered on for extended periods.
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4 Creative Cutter Tutorials

The four projects in this chapter provide you an opportunity to learn all the Creative Cutter
techniques you’ll use the most—and each project takes less than an hour to complete!

All projects assume you have already installed and set up the cutter and the cutter software.
If not, return to Chapters 2 and 3.

Tutorial 3 and Tutorial 4 use advanced skills and can be completed in any order after you are
comfortable with the skills taught in Tutorial 1 and Tutorial 2.

Tutorial 1: Import a Graphic File, Add a Shadow Mat,
and Fill a Page With Multiple limages

Import the Graphic File and the Software Program

Step 1:Insert an Images CD
1 Insert the CD shown in figure 32 into your computer’s CD-ROM drive.

Paxizles

%P\ ATIVE CUTTER =
BV (© Pazzles 2005

Mini Basic Additions CD
neludes:
The Basics Tutorial
Sawmple mages
Over 600 Images and Paper Piecing
Patterns from the Swap CD Collections

Figure 32

Creative Cutter MINI
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If the window shown in figure 33 opens, click the red X button to close it.

# Creative Cutten Additions CD

Pasizles '

Creative Cutter Additions CD

Tutorials

Browse CD Contents
View Our Website
i Contact Us

Figure 33

Step 2: Open the Pazzles Creative Cutter Program

1 Double-click the icon your desktop screen. See figure 34.

L
WinPCSIik
_reakjve
_ukker

Figure 34
2 Press the Esc key on your computer keyboard when you see the Welcome screen.

3 In the next window, click the Create A New Document image in the left hand side of the
screen. See figure 35.

= SignMace Wisual Dictiomary (89 8004 vector lngos) |

Figure 35
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o=

' IMPORTANT: For your page size on the mini, put in 11” for the width amd 8 height. See
o figure 36.

Recent pages

11.0x8.0"
24.0x24.0"
Page
Length: |11 Height: |8
@ inches " cm " mm

Cancel |

Figure 36

Find and Import an Image

1 Go to FILE, then IMPORT, then select IMAGE on the menu that pops out to the right.

2 Locate your CD drive under My Computer. To see all locations on your computer, click the
arrow by the Look in: My Computer box. See figure 37.

File import ‘Z‘El

Look ir: | 19 My Computer EREE 1=k

wLacal Disk (C: B 50y mmc (20

£C Addit ) # company-documents - =

.,}DVD-RW Drive (E:) 5uppertkE en SHIPE Look in: ] g My Computer j L= o EE-
) Memory Stick (G:) 221 an SHIPPING Ct

a CompactFlash (H:) lst Shared Documents

o SMJxD-Picture Card (1) Erin Cowan DC's Do

E ] >

Flepame: | T [~ Enable Preview

Files of tupe: |[x ) Ll Cancel

Page Ni

i Eile rfo

1

Figure 37
3 Double-click on the CD drive.
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4 Double-click on the sampleprojects05 folder. See figure 38.

File import

Lok in: J [ CC Addiions MM D) _:] L] o B
(8N (L) SAMPLE IMAGES
ECDIM-CURRENT (5 SamplePr 5

(C)CosETL ) The Basics Tutorial for Mini-Mighty
(S coseTa

() Pazzlesfonts

[ 5ample Bitmaps

File name: ] ™ Enable Preview
Files of ype: ~ [) - Cancel

Page No.:
File Info
— =

Figure 38

5 Select any file by clicking on it. For this project, we are using a file called Butterfly05.
:

Lok jn ] 19 SampleProjects0 lj = [ .

|| BABYOWERLAY DS EiE-IN [#]BROTHERSOVRLY 05
| BaLLooN 1_05 [#]e18_0s i
|#|BALLOON 2_05 [#|BIRTHDAY CAKE_DS  [] cAcCTUS 05

|#) BanmER 1_05 |#]BonET 05 |#) camera_os

|#| BARETREE_05 [#]Bow 1_05 |#) camprire_os

|#) BrskET_05 [#]Bow 2_05 |#)cap_os

& | ¥

File name:  [BUTTERFLY_05 Open ] ™ Enabls Preyiew
Files of bype: ][“ 1 Ll Cancel

P:gg e File Info

Figure 39
6 Click Open. The image you selected will appear on your 11x8 page.

Step 2: Create a Shadow Mat for the Image

1 To apply changes to an image, you first must select the image. To do that, click Tools on the
menu bar at the top of the screen, and then click Select All. See figure 40.

: Edit View Draw Text BGLEH Bitmap Shape Setting Window Help

BlE] | e —
Jajaa

Refresh work space F8

Erase FS

Measure

Magic Ruler* Plus and Pro Versions »
Show the color code

Figure 40
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2 Small boxes surround the image to show it has been selected. Click Tools again and then
click Outline to open the Transformation box. See figure 41.

IEH Bitmap Shape Setting Window Help

v Select <
Select all Cirl+A 3
Deselect all Ctrl4D

Refresh work space Fa& o
Erase F5 B

Measure

Transformation

v o T

A s

Transform
: Thlckness 0.02 _|:|
Circle

Magic Ruler* Plus and Pro Versions »

Show the color code Outline l et ]
Manipulate

Zoom

Sort inline path before outline Mumber :

Sort filing order

Dimension-ine 3

v Outline I_ Inline ‘

e ——— | Cortour [~ Gradiert I ™ Sor

Shadow

Gradient
Welding
Engraving 3

Rotation {30)
|

Figure 41

3 Make the following selections in the Transformation box:

. . Enter thi
For this setting ter this Notes
value
Thickness 0.08 In most cases, widths are between 0.02 and 0.10.
Number 1 The Number setting specifies the number of
outlines. Three is the maximum possible.
Outline Click the box to Unless you are outlining text, leave all other
select it. boxes blank. If you are outlining text, click
Break Text.

’ .

:6: TIP: To change a selection, click the Undo button > |.
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4 When you are finished making selections, click the yellow check mark at the lower-right of
the Transformation box. As shown in figure 42, the color of the image’s outline changes to the
color you selected.

Figure 42
Multiply the Image and Fill the Page
Step 1: Select and Position the Image

Use the Select Elements tool to select both the butterfly image and its outline. L‘

_‘*'_ TIP: Select Elements is the tool you will use the most.

1 To select the image and the outline, hold down the mouse button as you drag the mouse to
the right and down to create a box around the entire image. Drag a big box to be sure that the
entire image can fit inside. Imagine you are throwing a net around the image to catch all the
parts. See figure 43.

Figure 43
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2 Release the mouse button. When you do, little boxes appear around the image to show it has
been selected, as shown in figure 44.

Figure 44

3 To move the image, move the mouse over it until the cursor changes to the Move icon,
which looks like two crossed arrows. See figure 45.

+

Figure 45

4 Click the mouse button, hold it down, and drag the image to the location where you want to
place it on the page. For this project, place it about 0.5 inch down and 0.5 inch from the left.
Your page should resemble figure 46.

. =)

NNy
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NG -
( 0% 9)
AN

Click a corner box to resize the image.

Figure 46

5 Resize the image. Using the Select Elements tool, click one of the corner boxes. Then, hold
down the mouse button and drag it in or out to resize the image.

Step 2: Multiply the Image and Fill the Page Across

1 Make sure the image is still selected (it should be surrounded by little black boxes) If it is
not selected, click Tools and then click Select All to select it.
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2 Right-click on the screen. On the menu that opens, click Multiply.

Selectal cuisa

Figure 47

3

needed to fill the page across (side-to-side).

Multiply selected elements 3]

In the Number box on the Multiply selected elements window, type the number of copies

Number of copies : |&

Spacing
| S—1
0.1 0.4
1ol 3
Copy direction ——
1 -p
3 -

Angle : I_

\é Radius : ,—

| 0K | Cancel |

Figure 48

4 Set spacing values or leave the settings as-is.
5 For Copy direction, click the right-pointing arrow.

6 Click OK. The images appear across the page, as shown in figure 49.
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S TIP: If you make a mistake or must change the number of copies, click the Undo button *|.

W) W) W2)
(%ﬁo:) Cyd Y
Figure 49

Step 3: Multiply the Image and Fill the Page Down

1 Go to the Tools menu and click Select All. Small boxes surround the images on the page,
showing that all of them are selected. (If you prefer, you can use the Select Elements tool to

select all the images on the page. Click the tool and then use it to drag a box around all of the
images.)

2 Right-click on the workspace and click Multiply on the menu that opens.
3 Type in the number of rows you think will be needed to fill the page.

4 Click the down arrow for Copy direction.

Multiply selected elements '
Number of copies : |&

Spacing
0.1 T 0.4

Je[ 07 T o

Copy direction
1 -
3 -

Angle : I_
i Radius : ’—

| 0K l Cancel |

Figure 50
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5 Click OK to fill the page with the image, as shown in figure 51.

Figure 51

TIP: If you have too many or not enough images, click Undo | and start over.

Make the Cut

1 Open the Cutting Control Panel (figure 26 on page 24) by clicking the Cutting Control

Panel icon. ]i‘

2 Make the following settings on the Cutting Control Panel.

For this setting

Enter this value

Notes

Speed Slowest Start with the slowest when first learn-
ing. Most projects will be done on
slow or medium.

Panels Leave blank If you see 101, 201, your project is
larger than 11x8.

Material Use 12.00 for all papers that | Reflects the size of your paper.

are 12” and under.
Pressure For medium-weight Depends on the thickness of your
cardstock, try 145. paper and the blade length.
To change the pressure, highlight the
number and type in the new pressure.
Advance Leave blank. If the box is checked, clear it.

Color Select boxes

Click the black box.

Selects only the black cutting lines

3 Press Start to begin cutting.

» If the cut is good: Hooray!

* If you are unhappy with the cut, insert another piece of paper, adjust the pressure up or down,

and cut again.
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Pressure Adjustments

e If the blade cuts all the way through but the stop and start points do not meet OR the paper is
bunched up in the corners, the pressure is too high. Decrease it.

» If the blade does not cut through the paper, increase the pressure.

IMPORTANT: Do not be afraid to raise the pressure. Please DO NOT raise above 250. The
machine will not cut above this number.

=
=

Cut the Shadow Mat

Step 1: Cut the Shadow Mat Pieces

1 Put another piece of paper on the cutting mat for the shadow mats.

Insert the mat with paper into the cutter. See “Make the Cut” on page 40.
Open the Cutting Control Panel by clicking the Cutting Control Panel icon.
On the Cutting Control Panel, click the red box to select Shadow/Outlines.

For Speed, click Slowest.

A U1 A W N

For Pressure, if you are using the same weight paper, keep the pressure the same as the
previous cut.

7 Click Start.

Step 2: Separate the Shadow Mat From the Image (Optional)

1 Click the Select Elements tool.

2 Right-click on the workspace and click Color Selection from the menu.
_‘6'_ TIP: Turn Color Selection off by de-selecting it in this menu.
3 Click directly on the outline. When you do, everything in that color is selected.
4 Move the arrow over the image until the arrow changes to a cross (the Move tool).

5 Click and hold down the mouse button as you drag the outline away from the image.

Congratulations: you’re done!
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Tutorial 2: Create a Title With Connected Letters, Add a
Graphic, and Create a Shadow

Create your title

Step 1: Prepare the software

1 Open Pazzles Creative Cutter. See “Step 2: Open the Pazzles Creative Cutter Program” on
page 32.

2 Click the Create New Document image. See figure 52.

Figure 52
3 Setuptocutona 11” length by 8” height paper.

~ Recent pages

11.0x8.0"
240x24.0"

Page

Length: |11 Height |8

(" inches  cm " mm
................ S ool |
Figure 53
S TIP: These measurements will be saved in the Recent pages window so that next time you can
43 easily select this size.
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4 Your workspace should look like this:

Figure 54

5 Verify you have the most-used toolbars selected. To check, click the View menu, and then
click Toolbars. Select Standard, Tools, Manipulation, Selection and Zoom.
Step 2: Type the Title

1 To type a word, first click on the Text tool ﬂ‘

2 The rectangle on the workspace represents the paper. Click within the rectangle to select a
location, and begin typing the word. A black line appears where you clicked on the page.

Figure 55
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3 Type the word Summer.

o [o/L%] 4] | ale) xe | wlvlslsy

alalalala) 4]l vv|—of Hk| 2N2[a] 2]HH] NN RN

Llig e WVebcipan| )
3 :
5 [ s
El Q2 [EE oy e v s

1 | Summer

e ]
]
g

N\

&l

Figure 56

4 Click the Select Elements tool. L” It appears as a black arrow on the screen.

TIP: You will use the Select Elements tool often to select objects and to move them.

5 Click the word with the Select Elements tool. Small black squares appear around the word
to indicate that it is selected:

Figure 57
TIP: When you click on a typed word, the whole word is selected, not just the letter you
clicked on.

6 Choose a different font. Start by clicking the Font icon. F|

7 Click the Cutting button and scroll through the font | _
choices until you find Brush Script. (o) -

8 Type 2 in the Height box and then click OK.

Figure 58

TIP: Click the TrueType button to see all the fonts you have installed on your computer!
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Step 3: Connect the Letters

1 To make it easier to see your work, zoom in on the word. To
do that, find the Zoom toolbar and click the Zoom Selected
icon. See figure 59.

Figure 59

‘*'_ TIP: Make sure your word is still selected.
s3 Click on the word with the Select Elements tool. 4”

2 (Click Text in the menu bar at the top of the screen.

—
B File Edit View Dr@ools Bitmap Shape Setting Window Help

Figure 60

3 From the Text menu, click
Visual Text Spacing.

mmols Bitmap Shape Setting
Dictionary
B2
L Font Ctrl+F
rite tex
Figure 61 L|| writetext
—7  Textedition Ctrl+T

Mumber format

Move text

Copy text

Mirror text

Convert text to path
Clear text transformation
Rotate text

Text specification

Text spacing

Break Text 3

Align left
Align right
Center

il visual text spacing

Find font

Note that there
1S an arrow
pointing to the
right. There

are also small

boxes below

G002 002852
Figure 62

dllh
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4 Click the arrow
pointing to the right.
Then, hold down the
mouse button and
drag the arrow to the
left. Watch how the
little boxes move as
you drag the arrow.

Figure 63

5 Release the mouse
button and watch as the
letters move to the location
represented by the little
boxes. See figure 64.

Figure 64

6 To weld the letters into
one complete word, the
letters must overlap as
shown in figure 65.
Continue to adjust your
word by moving the arrow
left or right until your word
looks like the one shown.

Figure 65

TIP: You can adjust individual letters by selecting the box below a letter and moving it with

your mouse.

7 Click the Select Elements tool L” and then click the word to select it.
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8 Click on Tools and select Welding.
The overlapping letters weld together.

Figure 66
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m Bitmap Shape

v Select
Select all

Deselect all

] Refresh work space
— | FErase

Measure

Magic Ruler®
Show the color code

Transform
Manipulate
Zoom
Circle

Setting Window Help

Ctrl+a
Ctrl4+D

F&
F5

Plus and Pro Versions

Sort inline path before outline

Sort filing order

Dimension-ine
Distortion
Outline
Shadow

Gradient

Engraving

Rotation {30)

Cirl+¢

3

v T

AN Y

Figure 67

Congratulations! You just made your first title!
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Cut your Title

Step 1: Select the Inside and Outside Part of the Word

TIP: Before typed text is welded, you can select it by clicking anywhere on the word. All parts
inside and out will be grouped together with one click. After you weld the word, the inside and
outside parts are separate and you must select both the inside and outside parts. Be sure to select
all the parts. If you don’t, you will leave pieces behind when you move the word.

1 To select both the inside and outside parts
of your word, click on the Select Elements tool. L”

2 Click a spot on the workspace that is above and to the left of the word. Hold down the
mouse button as you drag the mouse to the right and down to create a box around the entire
word.

TIP: Drag a BIG box! You must drag a box big enough to fit the entire word inside. Otherwise
you may not get all the parts.

Click here

x

| |

| |

| | . . .
| |

| |

| | " "
| |

| |
Tip: Think of this as throwing a net Release the mouse button and little
around the word to catch all the parts. boxes will appear around the word to

indicate it is selected.
Figure 68

3 Position the word:
To move: Move the mouse over

the word until the arrow ,_I_, S @] m“ﬂj Um @ [ﬁ

changes into a cross symbol.

move symbol
Place the word approximately

1" down from the top and 1" in
from the left side of he page.
Click the mouse button, hold
button down, and drag the word
to the proper location on the

page.

Figure 69
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Place a 8.5x11 paper on the cutting mat.

4
For this setting Enter this value Notes
Speed Slowest Start with the slowest when
first learning. Most projects
will be done on slow or
medium.
Panels Leave blank If you see 101, 201, your
project is larger than 11x8.
Material Use 12.00 for all papers that | Reflects the size of your
are 12” and under. paper.
Pressure For medium-weight card- Depends on the thickness of
stock, try 145. your paper and the blade
length.
To change the pressure,
highlight the number and
type in the new pressure.
Advance Leave blank. If the box is checked, clear
it.

Creative Cutter MINI
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5 Press Start to begin cutting.
e If the cut is good—Hooray!

* If you are unhappy with the cut, close the Cutting Control Panel window and go back to Step 3.
Move the title to another spot on the page.

- TIP: If the blade cuts all the way through but the stop and start points don’t meet OR the paper
43 is bunched up in the corners, the pressure is too high. If the blade does not cut through the paper
increase the pressure.

_‘*'_ TIP: DO NOT BE AFRAID TO RAISE THE PRESSURE! It is perfectly acceptable to cut

- some cardstocks at 245. Since 245 is the highest pressure that the Mini can be set at, if the
image you are cutting does not cut on the first pass, select the image, right click with your
mouse and select Duplicate from the list that appears. You can also select the image and press
Art+D on your keyboard once to make 1 copy and twice to make 2 copies. Then open your
Cutting Control Panel and press Start. Your cutter will automatically go over the image as many
times are you selected to duplicate it. Please note that you will not see those duplicate lines, as
they are place right on top of the original lines.

Add a Graphic to the Title

Step 1: Prepare the Software
1 Close the Cutting Control Panel window by clicking on the red X. m

2 Do not close the Summer page. You will be adding a graphic to the word.

3 Insert the CD shown in figure 70 into the CD-ROM drive of your computer.

Paxizles

i %HIAH\/\ CUTTER .
C (©) pazzles 2005

Mini Basic Additions CD>
tneludes:
The Basies Tutorial
Sawmeple mwages
Over 600 (mages and Paper Piecing
Patterns from the Swap Cb Collections

Figure 70
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4 If the window shown in figure 71 opens, click Cancel to close it.

@ Creative Cutter Additions CD

Payizles

Creative Cutter Additions CD

For Creotive Cutter Mini § Mighty

- " )
e SRS
Browse CD Contents

View Our Website

Y
Gontact Us

L
Figure 71

Step 2: Import a Graphic

1 Click File at the upper-left corner of the menu bar at the top of the Win PCSIGN screen.

ﬁ File E View Draw Text Tools Bitmap Shape Settng Window Help

T ——

Figure 72

2 Click Import. Then select IMAGE. See figure 73.

' WinPCSIGN - [WinPCS1]
B[00 Edt Vew Draw Tet Tooks Ginep Shape Settng Windon Hep

[ . 3
iyl awo o] x[e| wl¥l:

o o

= sae s
Sae Bs...

| Captwesoeen At

ﬁ St snes

] hcquie

K Digtal caneras Pus andPro Yersions ¥

T F

| Export ChikE EPS, AL
Send... IMAGE.

;

L Son MK loges atl Girioee

= Produckon sheet PRH

& Pt [ ™

— Frandprint VTP, WRC (VP or WIRPCSIG)

5 WinPCSIGH CLE
Frin preview

& Frin setup...

B cmngment s and o Vesions

2 Cutting panel (Cut) Fi0

a el

= 1 DDIBWORD BOOKSIALLTTARS

9 2SUMMER NS

T afyes

ﬁ 4BUTTERFLY 05

@ 5latisCad

q Ext

Figure 73
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3 Find your CD drive under -
MY COMPUTER File lpnrt

Figure 74 e Local Disk (1)

B oy mmc
L 1) xmmpany-dn[umants
\&DVD—RW Drive (E:) xsupportKB an 'SHIPF

) Memary Stick (G:) S#pat on 'SHIPPING Cf
B CompactFlash (H:) st Shared Documents
“a# SMD-Picture Card (11} 1Erin Cowan DC's Doo

4 >
File hame: ] Open 1 I™ Enable Praview
Files of type: |[x 4] _:J Cancel
Page Mo.: .

File Info
ro— e

‘*' TIP: Click on the arrow button by the window to see more locations on your computer.

’ -

I Lock in: ] i My Computer _vj

Figure 75
4 Double-click on the CD drive.
5 Double-click the SampleProjects05 folder.

File import

Figure 76 Look | () CC Addiions b (D) Yeme B
():

| COM-CLIRRENT 5
ICHCOSETL I3 The Basics Tutarial For Mini-Mighty
(SIC0sETS

(yPazdesfonts

(L) 5ample Bitmaps

5

File name; ] Open I [™ Enable Preview
Files of type: i[‘_‘] :_1 Cancel
Page Mo.:
File Info
- [=E ]

6 Double-click the Summer Sun05 file.

File import

Look jn I 19 SampleProjects0s :‘] & & B
] BABYOVERLAY DS )L 05 |#]eroTHERSOVRLY 05
[#]BALLOON 1_05 #]818_05 [EleurTerFLy_os
[#]BALLOON 2_05 [#|BIRTHDAY CAKE_DS  [¥]cacTUS 05
] BANMER 1_05 [ BOMNET 05 ] camera_os
| BARETREE 05 [#Bow 1 05 |#)camprme_os
[ BrskET_05 [#|Bow z_0s |#)cop_ns
4 | 3
. Fiename:  [BUTTERFLY_06 I™" Enable Preyiew
Figure 77
Files of type: j[‘ % _vJ Cancel
Page N
s File Il
i

Move and Edit the Graphic Image

1 The image (summer sun) should have the selection boxes (little black squares) around it. If
it does not, click on the Select Elements tool. L” Then drag a box around the sun to select it.
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2 The Summer Sun image should appear in the work space As shown in figure 78..

T Tk g e S St
B s ¥ & F|x e x| ®|v|=S
] 58] S5 [fof wl] 2SN [2lA] 2l NNENE
g Fre | B

[oleo]s|8[8f]]1 |# 7]

1k

B |2[@le [o |2 [l ¢ o)o]d]ule]s |2 7] |y

Figure 78

d TIP: Be sure to drag a box around the entire sun to catch the inside parts and the outside parts.

3 Resize the sun if needed by clicking on a corner box. While holding the mouse button down,
push in or pull out to resize the sun.

Figure 79

Weld the Title and the Image

1 Move the summer sun image so that it overlaps the Summer title.

_‘*'_ TIP: To move the image, hover the Select Elements tool over the image until it changes into
- the Move tool.

“/"f NOTE: 1If you leave parts behind, first click UNDO ¥ | to void your last action. Then drag a
box around the sun to grab all the part

2 Select the outsides only of the sun and the title Summer. To do so, click the outline of the
sun with the Select Elements tool. Then, while holding down the surrT key on your keyboard,
click on the outside the of the title Summer. Boxes should then surround Summer and the sun,
as shown in figure 80..
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Figure 80

3 Click Tools and then click Welding to weld the title Summer and the sun together, as shown
in figure 81.

Figure 81

Congratulations! You have just created a title with an image attached!

Create a Shadow Mat for the Title (Optional)

Step 1: Create the shadow

1 Select the entire title by dragging a
box around it with the Select Elements tool. L”

Resize the title to your liking by clicking on one of
the corner boxes. Hold the mouse button as you pull
out to enlarge or push in to make smaller.

Figure 82

2 Click on the screen away from the title. This will
de-select the title and the boxes will disappear.

3 Select the outside of the title only by using the Select Elements tool L” to click on an
outside line. This will allow you to create a shadow only for the outline.

TIP: For this project you will not create inside parts for the shadow. In future projects, if you
would like to have the inside parts cut out on the shadow, select the entire title.
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4 Go to the Tools menu at the top at the screen and then click Outline.

Bitmap Shape Setting Window Help
v Select
! selectal Cirl+a
Deselectal Cul+D

T

1 Refresh work space F8 P
o Erase Fs F

Plus and Pro Versions >

Ciri+C

Figure 83

5 Make the following selections in the Transformation box (see figure 84).

For this setting Enter this value Notes

Thickness 0.08 In most cases, widths are
between 0.02 and 0.10.

Number 1 The Number setting specified
the number of outlines. Three
is the maximum possible.

Outline Click the box to select it.
Then, choose the color of the
outline by clicking on the
rainbow color cube.

Break Text Click the box to select it. Check this box so that you
will be able to separate the
title (text) from the outline.

Transformation

Outline l Shadow ]

utline [ Inline
Cortour [ Gradient @

Figure 84

6 Click the yellow check mark to accept the outline.
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.

_‘*'_ TIP: 1f you need to undo something click the Undo tool at the top of screen. |

The Outline now appears in a different color around the title.

Figure 85

Step 2: Separate and Position the Shadow

1 Zoom the project in to make it easier to see by clicking on the Zoom Selected tool.

Figure 86

2 Click away from the title to de-select it.

3 Select the red outline by clicking on it with the Select Elements tool. L”

4 Move the mouse until you see the arrow change to a double cross that indicates Move.
5

Click mouse button and drag the outline away from the title.

Figure 87
6 Position the title where you want it on the page:

Drag a box around the entire title using the Select Elements tool. L” Then move arrow over
title until you see a double cross. Click and hold mouse button down as you move the title into

place.
_‘6'_ TIP: Remember that you need to drag a box around the entire title to “grab” all the inside and
a5 outside parts.
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7 Position the shadow below the title.

8 Cut your project. For instructions, see “Make the Cut” on page 40.

_‘*' TIP: Cut the title and shadow twice using two different colors of paper. Then you will have two
s> titles with mats.

’
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Tutorial 3: Prepare, Scan, and Convert a Basic Line
Graph to Cutting Format

N
’ I.. Al
s

58

In this tutorial, you will learn how to convert a basic line drawing into cutting format to create a
cutting image. The line drawing can be your own creation or one found in a coloring book,
workbook, or other resource.

NOTE: Tutorial 3 and Tutorial 4 introduce advanced skills. Be sure you are comfortable with
the skills introduced in Tutorial 1 and Tutorial 2 before attempting the advanced tutorials. You
can complete advanced tutorials in any order.

Prepare the Line Graphic

The most easily converted graphics are simple drawings with few intersecting lines.

1 Enlarge the drawings if necessary. The drawing should be at least 3"x 3". Bigger is better!
See figure 88.

_______ - - - - - - -

(@]

L] ] L1 ]

m

Figure 88

2 Use white out to erase parts of lines that are not wanted. Look in particular at any
intersecting lines. Draw additional lines if desired See figure 89.

g

Y « W _ N

Figure 89

TIP: In some cases, it might be better to trace the drawing. Always trace if the original
drawing has rough lines.Use the fine-point permanent marker such as a Zig pen.
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Scan the Drawing into Pazzles Creative Cutter

1 Open the Pazzles Creative Cutter program.

1 Double-click the icon your desktop screen. See figure 90.

I|I|'|I|I | M F' I:: .
_reative
_ukker

Figure 90
2 Press the Esc key on your computer keyboard when you see the Welcome screen.

3 In the next window, click the Create New Document image at the left of the screen. See
figure 91.

B Search fos boge In SignMax Visual Dictiomary (89 800+ vector loges) |

Figure 91
4 In the Setup page box, type 11x8in the Height and Length boxes.These settings set up the
cutter to cut a 11x8 paper and reflect the actual available cutting space on the paper.

IMPORTANT: Be sure that your page appears to be in landscaped orientation as shown in
“Starting and Using the Cutter” on page 22

TIP: Be sure you have the toolbars used most often selected. Click View and then click
Toolbars. Then click Standard, Tools, Manipulation, and Zoom.

5 The very first time you scan, you must select the scanner. Make sure you have connected
your scanner to the computer and that the scanner is powered on. Click File and then click
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Select Source. You might need to power on the scanner and then close and then re-open your
computer. Be sure to turn the scanner on before turning on the computer.

mEdit View Draw Text Tools Bitmap She

0 MNew Ctrl+N
| — Open Ctrl+0
+  Close
[—; Save As...
4 Capture screen Alt+C
A T
T Acquire
——  Digital cameras Plus and Pro Versions
S
— Import Cirl+I 3
—
M
¢ Sign MAX logos Ctrl-+
[C  Production sheet
g  Prnt... Cirl+P
25 Fitand print

an |8

% Print preview

ﬂ Print setup...

@
~ | Cutting panel (Cut) F10
_@[ 1 SchoolBus

@ 2 paintcanpattern
*® 3 paintcanlidpattern

4 hoppyEastereggfont
5 Eastereggfont

Exit

Select Source

Sources:

Visioneer Scan Manager Pro 1.0 (32-32)

Cancel

Figure 92

6 In the Select Source box, highlight your scanner and click Select. If you have more than
one scanner, be sure to select the correct one! See figure 92.

7 To scan, click File and then click Acquire to open your scanner software.

" WinPCSIGN - [WinPCS3]
B i Edit View Draw Text Tools Bitmap Sha

| Capture screen Alt+C
M Selectsource

[:\ Save As...
A

Acquire
—|  Digital cameras Flus and Pro Versions b

Import cri+ »

[ sl 1

o sign MAX logos i+l

[ Production sheet
| Prnt... ctl+p
Fit and print

Print preview
Print setup...

Cutting panel (Cut) ~ F10

1 5choolBus
2 paintcanpattern

3 painteanlidpattern
4hoppyEastereggfont
5 Eastereggfont

I8 | 2@l e @ [ ]|

Exit

Figure 93
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8 Scan the drawing as black and white bitmap. See figure 94.

TIP: Your scanner software might look different from the pictures.

What do you wantto scan? | [E-—---o-

Paper source v
’ Flatbed v ]

Select an option below for the type of picture you
want to scan.

O Color picture
O Grayscale picture

(® Black and white picture or text <
(O Custom Settings

You can also:
Adjust the quality of the scanned picture

Figure 94
9 Set the resolution (DPI) to at least 250.

Advanced Properties \

Appearance
Brightness:
3 P ]
Contrast )
3 P ]
Picture type:
\Color picture v ‘

10 Scan the image.
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Convert the Scan Into Cutting Format: Vectorization

Your scanned image should be visible on the Pazzles Creative Cutter workspace, as shown in
figure 95.

LI

Figure 95

1 Verify that the image is selected. If it is, it will be surrounded by small boxes. If it is not
selected, click the Select Elements tool and select it.

The image must be converted from pixel format (dots) to vector format (lines). This process is
called vectorizing. Think of it as connecting the dots.

TIP: The smoother your lines are to begin with and the closer your dots are together,
(resolution), the better the cutting image. Be sure to scan at 250-300 dpi.

Most computer graphic programs create objects with tiny dots called pixels. The number of
pixels per inch, which is also referred to as dots per inch (dpi) is called the object’s resolution.
The higher the resolution, the more dots per inch. And, the higher the resolution, the more
detail in the graphic.

To see the difference between an image created at 72 dpi and 300 dpi, look at figure 96. As you
can see, the closer the dots are to each other (and therefore, the higher the resolution), the
smoother the cutting lines and curves. For more information on working with graphics,
see“Working With Graphics” on page 105.

-
e, saler.

300 dpi

Figure 96
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2 On the menu bar at the top of the screen, click Bitmap.

ols Bitmap Shape Setting Window Help

é Convert to image

See on screen Alt+E

Aotonabe Vectorzaton Pus nd PoVersen

. Region » .

Change resolution

Color configuration > Edition

Special effects »

Path Tolerance

Rotate image » [ H

Italic image Italic
Figure 97

3 On the menu that opens, click Vectorization, and then click Automatic Vectorization. See
figure 97. The Vectorizing tool, which looks like a magic wand, becomes available.

4 Using the Vectorizing wand, click on the image. See figure 98.

* If the Working... box appears, you have successfully vectorized the image, and you can go on to
“Edit the Image” on page 65. The Working... box provides a running tally of the percentage of
vectorization that is complete. See figure 98..

e If the Working... box does not appear, change the resolution (see “Changing the Resolution: What
to Do If You Get a MessageAbout Converting the Image to Black and White” on page 64).

Figure 98
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Changing the Resolution: What to Do If You Get a MessageAbout
Converting the Image to Black and White

If you get a message stating that you must convert the image to black and white, it means that
you did not scan in black and white bitmap. Click OK and complete the following steps.

1 Click the Bitmap menu and then click Change Resolution. The Change Resolution tool,
which looks like a cog wheel, becomes available.

2 Using the Change Resolution tool, click on the image. When you do, the Bitmap
resolution window opens to display information about the image. See figure 99.

Bitmap resolution 5]

Bitz per pixel Dithering method
1 18 " Mone " Sierra
{4 o " Flayd Stein~ { Stevenson
wg o3 " Stucki " Jarvis
" Burkes * Ordered
(0] 8 | Cancel
Figure 99

3 Working step-by-step, bring the settings down to 1 (bits per pixel) and None (Dithering
method). Here’s how to do it with the example shown in figure 100.

Bitmap resolution

Bits per pinel Dithering method
N |- * Nore " Siera
4 74 " Floyd Stein ¢ Stevenson
(g o " Stucki " Jarvig
" Burkes " DOrdered

= ie-Green-Flet

’Tl Lancel

Figure 100

1 Click 4 and None and then click OK.

2 (Click the image again with the vectorizing tool.
3 Click 1 and None and then click OK.
4

Repeat the procedure “Convert the Scan Into Cutting Format: Vectorization” on page 62.
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Edit the Image

1 Delete the original bitmap. To do so, click the Select Elements tool, click on the original
drawing, and then press the pELETE key on your keyboard. The scanned image remains on your
screen. See figure 101.

2 Delete the box that is outside the image. Click on the box line with the Select Elements tool
and then press DELETE on your keyboard.

Figure 101

3 Delete unwanted lines. Select a line by clicking on it with the Select Elements tool and then
press DELETE. See figure 102. The image on the left shows unwanted lines in red. The image on
the right shows the image after the unwanted lines are deleted.

TIP: You can identify a line that is selected for editing because it is surrounded by black boxes.

{/"bﬁﬁ@j

Lo AN

Figure 102
4 Move the image to the upper-right portion of the workspace.

To move the image, first select both the inside and outside of the image by clicking a spot
above and to the left of the image. Then, hold down the mouse button as you drag the mouse
to the right and down to create a box around the entire image. (Draw a big box to ensure you
catch all parts of the image.)

When you release the mouse button, small boxes that indicate the image is selected should
appear, as shown in figure 103.
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Figure 103

With the image selected, move the mouse over the image until the arrow turns into a cross
symbol (the Move symbol). Click and hold down the mouse button as you drag the image into
place on the page. Place it about one inch down and one inch in from the left side of the page, as

shown in figure 104.

O el
Dy

Figure 104

5 Use the Move Point tool to fix small bumps and flaws like the one shown in figure 105.

,_\\\
™ -
—

~ ‘

?gauu a

./ N 7N, |
\ U & N i PR
_\\ /_ﬂ \ ) — -
e - N //
Figure 105
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*  Select the tool and click on the bump to grab the line.
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*  Hold the mouse button down and push in or pull out to fix the flaw, as shown in figure 106.

T

(I

() .=l
\J/’\\\

L

M

(J

| P - —
\ ﬁ//ﬁ A f]/ N\
. R o —~
\,J N,
Pull out
Figure 106
_‘*'_ TIP: Cutting images are made of lines (segments) and points. Points are where two lines meet.
- If you push or pull in the middle of a line you create an arc. D If you push or pull at a point

you create an angle. D

6 Fix bumpy, rough lines, like the one shown in figure 107 with the Line Smoothing
(Replace Segment) tool. Click the tool above the bumpy area. Then, while holding down the
mouse button, drag along the line to a spot below the bumps. Release the mouse button to
replace the bumpy line with a smooth one, as shown in figure 108.

Figure 108
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Multiply the Image, Fill the Page, and Cut the project

1 Use the procedure “Multiply the Image and Fill the Page” on page 36 to create multiple
copies of the image and fill the page.

2 Place a 8.5x12 paper on the cutting mat.
3 Insert mat into the Creative Cutter.
4 Starting with step 2, follow the procedure “Make the Cut” on page 40 to cut the project.

Congratulations! You’ve completed the tutorial!
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Tutorial #4: Hand Vectorizing a Graphic or Photo

=
=

You can convert any drawing, graphic, or photograph to a cutting file by hand vectorization. In
simple terms, hand vectorizing involves using some basic drawing tools to trace around the
image. You might find that this becomes your preferred method of converting graphics!

NOTE: Tutorial 3 and Tutorial 4 introduce advanced skills. Be sure you are comfortable with
the skills introduced in Tutorial 1 and Tutorial 2 before attempting the advanced tutorials. You
can complete advanced tutorials in any order.

1 Open Pazzles Creative Cutter and create a blank 11x8 page.
IMPORTANT: Be sure your page appears in landscaped orientation see “Starting and Using
the Cutter” on page 22.

2 If you are importing an image, use the instructions that follow. If you are scanning an
image, go to “Trace the Graphic (Hand Vectorize)” on page 71. Be sure to verify your scanner is
selected, connected to the computer, and powered on. For a review, see “Scan the Drawing into
Pazzles Creative Cutter” on page 59.

Import an Image Saved on Your Computer

1 Click File from the Pazzles Creative Cutter menu bar.

@@l s |2 el v o

Figure 109
2 Click Import and then click Image. See figure 109.

3 In the File Import box, find the location of our saved graphic or picture. To view small
pictures of your image files, click the View tool and choose Thumbnails. See figure 110.
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4 Scan the drawing as a Color Picture or Photo, at a resolution of at least 250. When you do,
the image appears on the Pazzles Creative Cutter workspace, as shown in figure 111.
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Figure 111

Resize the image to fill the screen. To do so, first click the image with the Select Elements tool.
Click a corner handle and hold down the mouse button while you drag the picture to a larger

size. See figure 112.
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Trace the Graphic (Hand Vectorize)

Step 1: Review the Location and Uses of Tools

The tools described in the following table are those that are most-often used during hand

vectorizing.

Tool

Toolbar icon

Notes

Segment from Path

As you draw a segment with this tool, it will
automatically join the segment previously
created. To start drawing, click and drag a line.
To continue drawing lines, click on a spot
further away and the line will follow.

Segment toolbar

Double click the Segment from Path icon to
bring up the Segment toolbar. Use the first two
buttons to trace around the image.

Segment tool

Draws independent segments. Used most often
for accent lines.

Move Point tool

N I

Shapes the lines to fit the picture.

Join Two Points

Joins the ends of two lines. To use, drag a small

tool #.,', box around the ends.
Magnify tool Zooms in on an image so you can see detail
(e better.
Show Open Paths —_— Locates the adjoining ends of segments that have
tool ? * not yet been connected.

Step 2: Set the Line Thickness and Color

1 Double click on the Segment from Path tool to open the Segment toolbar. See figure 113.

Click the Segment from Path tool.

2
3 Click the Pen and Brush tool to open its window. See figure 113.
4

Change the Pen width to 0.04 thickness and click Apply.
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%, WinPCSIGN - [WinPCS1 *] CIOx
B Fle Edt View Draw Text Tools Bitmap Shape Seting Window Help a0 =R

“|e] s & F|s]e] - [e] w[z]sE

Ll e | T ebcipan| ‘
1 2 3 4

5 [ 7 8 5

TR

KisaCit? i

Feset Apply

B Al@ls |2 2 ]a)m | x]ofo]d]u

24¢

| >
For Help, press F1 Hoo woo" X:13.229 ,¥: 2.909 | | A

Figure 113
5 Click the Color Palette tool to open the Color window. See figure 114.

6 Right-click your mouse button on a color for the tracing line. Choose a color that will stand
out from the picture, such as red or bright pink.
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Step 3: Begin Tracing the Picture
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1 Click the Magnify tool and use it to enlarge a section of the picture.

2 (Click the Segment from Path tool.

3 Click on a starting point and hold the mouse button down as you drag the starting line. See
figure 115.
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4 Continue tracing around the picture by clicking on a spot some distance away from your
first line. As you click along the outline of the picture, a line fills in between the points. See

figure 116.
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Step 4: Continue Tracing and Refine

1 Create smaller segments around tight areas, \
as shown in figure 117.

2 Click the Redraw tool @ l to turn the line color to red (or whatever color you have

chosen).
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Figure 117

3 Continue tracing around the picture until you reach the starting point. The ending and

beginning points should connect automatically. See figure 118.
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4 Click the Magnify tool to enlarge a section of the picture if necessary.

5 Click the Move Point tool. /1‘ You will use it to shape the lines to fit the picture See
figure 119. N
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Figure 119

6 Click on a segment that must be rounded and hold down the mouse button as you move the
line in or out.

e To round the segment, click the middle of the segment.
* To resize the segment or create a point, click an end point of the segment.

7 Continue shaping the lines as needed all around the outline.
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Step 5: Outline Other Features

1 Continue to use the Segment from Path tool to outline other features. Keep in mind that
when using the Segment from Path tool, the end of the line must connect with the beginning

point.
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2 Use the Draw Segment tool to add individual accent lines. These accent lines do not

connect to the lines you made previously. See figure 121.
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3 Use the Move Point tool to shape the accent lines.
*  To round the segment, click the middle of the segment.
* To resize the segment or create a point, click an end point of the segment.

4 Use the Join Two Points tool to connect the ends of lines. Click and hold down the mouse
button while dragging around the end points that need to be joined. When you release the mouse
button, the ends should join together. See figure 122.
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Step 6: Check your Work

1 Using the Select Elements tool, click on the image and hold down the mouse button as you
drag a box around the new outline. When you release the mouse button, all lines within the box

are selected.

2 From the Edit menu, click Copy and Paste to make a copy of your project. The copy will

assist you in seeing if any adjustments must be made. See figure 123.
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3 Make changes and adjustments as desired.

4 Click on the graphic (photo) portion of the screen to select the photo.

=
=

will delete the entire project.

IMPORTANT: Do not drag a box around everything and do not use Select All. If you do, you

5 Press the pELETE key on your keyboard to remove the photo. When you do, only the newly

created cutting image remains on the screen.
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6 Click the Show Open Paths tool to find any end points that need to be connected. The
program zooms in on all loose ends.

* Ignore the open ends you wish to leave open.

*  Fix the ends you wish to close. To do so, use the Join Two Points tool to drag a small box around

the points to connect the ends.

" WinPCSIGN - [KirstenLooksA *] L X
B Fle Edt Vew Draw Text Toos Blmap Shape Seting Window Help B

D@d & (m|l s ¥ A F|aje| w3y |= e
al alala|a| ClisTre EYeocia| N i e ]
FE R T T O T S ?

|88 [> ||| |E|= | 8] | | ]
|t ||

Al W[ |+ o] 8]V[®]3

=

1=

|EE |~ & |2 |22 [ e [0]o < [2]~]4 »]=

v
< >
For Help, press F1 Hi4.334 w4321 " X:4.231,Y:10.779 00:45:27

6.

Figure 124
7 Your project is done. See figure 124. Be sure to name and save it.

Congratulations! You completed the tutorial!
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5 Manipulating Letters and
Shapes

This chapter provides the information you need to add special effects to a variety of fonts and
images.

Tools Used for Manipulating Letters and Shapes

Tool Toolbar icon Use to...

Text tool Write text. Click the icon, click on the screen
X I 2 where you want to start typing, and then type the
text.

Font tool Select a font and font size to apply to text. Pazzles

Creative Cutter comes with cutting fonts, which
F are optimized for use with the Creative Cutter.
You can also use TrueType fonts that are stored in
your computer’s Windows Fonts folder.

Select Elements Select letters, words, objects, and parts of objects.
\ To move, resize, or manipulate an object or word,
you must first select it.
Select the text on a page for previewing how it
will look in other fonts. Click the text with the
Select Elements tool, click the Text menu, and

then click Font to open the Font preview
window.

Erase tool Erase all or part of an image. Click on the part of

o | the image you want to erase or drag a square

around it. If you want to erase a letter or parts of a
letter, convert the text to a path first.
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Tool Toolbar icon Use to...
Undo . Reverse the last action completed.
X
Redo Reverse an undo.
Zoom Enlarge parts of the page so you can see them

better. Click and drag around the image while
holding down the mouse button.

Zoom toolbar

Enlarge or reduce the size of a selected object to
help while editing it.

Change Color
tools

Open the color palette to change the color of an
outline or fill. Right-click on a color to change line
color; left-click to fill with color.

Mirror/Rotate

Mirror: flip an object vertically or horizontally.
Rotate: turn the selected element by the number of
degrees you specify.

Move point

Select a construction point on an element and then
move it in, out, up, or down. Move Point is
helpful in smoothing out imperfections in
drawings. Click the center of a segment and move
in or out to create an arc.

Break and Move

Place a break in the image line and then bend or
manipulate the line.

Cut Straight Line

Cut a straight line across an object to separate it
into two separate parts.

Join two points

Join the ends of two lines together.

Cut Path

Cut a line into two sections.
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Tool Toolbar icon Use to...

Measure Tools menu Measure the size of the project. From the Tools
menu, click Measure. Then, click the project start
point, hold down the mouse button, and drag the
measuring line to the end point.

Drawing tools Draw shapes. To view the drawing tools, click the

a0 |fz|= rectangle.

Justify Position objects correctly. You can justify the

? position of objects centered to each other, on the
= page, or to the left, center, or right. Click the
Justify tool to open the Justification toolbar, and
then click the type of justification you wish to

apply.

Justification
toolbar Justification

=|wlarn B EEIEE=

Changing the Look of Images and Text

You can change the look of text and images in many different ways. The easiest is to change the
font in which the text appears. More complex techniques include adding shadows, distorting
text, and creating curved words and titles.

Changing and Previewing Various Fonts

1 Using the Select Elements tool L‘ , click the text you want to change to select it.

2 Click the Text menu and then click Font. When you do, the Font box opens with a preview
of the selected text in the current font.

3 Click the type of font you wish to use, either True Type or Cutting. (Cutting is
recommended), and then click a font from the displayed list of available fonts. The Preview
boxes show the text with the new font applied.

4 When you are satisfied with your font selection, click OK to close the Font box and apply
the new font to your text.
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Moving and Resizing Images

Use the Select Elements tool to manipulate a single element or multiple elements.

Selecting an Object

With the Select Elements tool selected, click the item(s) you want to resize, move. or change.
See figure 125.

* To work with a single element, click the element.
* To work with a group of elements, drag a box around a group. See figure 125.

* To select both the inside and outside of an object, drag a box around the entire object.
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Resizing an Object

1 Select the image with the Select Elements tool. When you do, small black boxes appear
around the image. See figure 126.

~ WinPCSIGN - [WinPCS1 *]
B Fle Edit View Draw Text Took Bitmap Shape Seftng Window Help

D@ ¢ =e| el ¥ L Fl e x W |37 |75 || Clis T | Wivebcipat| | G| G [@
il . il : 2 E] 4

/\

Blr@ls |5 |2 [=18 [k [o]o]e]o<]H | 7]

L
Click on a corner square,
hold mouse button down,
and slide in or out to resize.

6

For Help, press F1 H:2.607 ¥

Figure 126

2 Click one of the small black boxes to resize the image. While holding down the mouse
button, click one of the black boxes and push it in or out.

Moving an Object

1 With an object displayed on your screen, use the Select Elements tool to select it. (If you
prefer, you can use Select All from the Tools menu.

2 (Click directly on the center of the object and hold down the mouse button. When you do,
the pointer changes to a cross (the Move tool).

3 While continuing to hold down the mouse button, move the object on your page.

_'_ TIP: Another method of moving objects is to click the center of the object, release the mouse
s button, and use the arrow keys on your keyboard.

Filling a Page With an Image (Multiplying)
You can easily fill a page with multiple copies of the same image.
1 Click the Select Elements tool and use it to drag a box around the image.

2 Right-click on the workspace and click Multiply on the menu that opens. When you do, the
Multiply selected elements box opens. See figure 127.

3 Type in the number of rows you think will be needed to fill the page.
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4 In the Copy direction box, click the arrow for the direction you want to place the objects.

Multiply selected elements @
Number of copies : |§
Spacing
01 T 0.4
oL T e
Copy direction
1t -
3 =

Angle : [_
X | Rodus: [0

0K Cancel |

Figure 127

5 Click OK. The page fills with the image, as shown in figure 128.
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Figure 128

_‘*'_ TIP: If you have too many or not enough images, click the Undo tool | and start over.

\1",;2’ NOTE: You can also resize the entire group of images to fit the page. Click Select All and

move the corner box in or out to resize.
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Measuring the Size of a Project

1 From the Tools menu, click Measure. See figure 129.
2 Click the project’s starting point

3 While holding down the mouse button, drag the measuring line to the end point. The
distance is displayed at the bottom of the screen.
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Creating Outlines and Shadows
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Figure 130

You can create an outline shadow of any letter, number, word, or shape. Use the instructions
that follow.

1 Write a word or open an image.
2 Select the word or image.
* To outline both outside and inside parts, select the whole image by dragging a box around it.

* To create a shadow of only the outside, click on the outside line. (For text, first convert the text
to a path.)
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3 From the Tools menu, click Outline. When you do, the Transformation box opens.
4 In the Thickness box, type a thickness (between 0.02 and 0.15) for the outline.

5 In the Number box, type the number of outlines you wish to apply. Do not exceed three
outlines.

6 Click the Outline box to check it.
7 Click the color cube to choose a color for the outline.
8 Click the Break text box to check it. This allows you to separate the text from its outline.

9 Click the yellow check mark at the lower-right of the Transformation box to save and
apply your outline selections. To separate the outline, see “Separating the Outline From the
Word or Image” on page 88.

Outlining Problems and Solutions

If the program aborts while you are creating an outline or shadow, any of the following issues
might be causing the problem.

*  The image or word has too many outlines. Do not exceed three outlines.

*  You attempted to outline a circle. Circles cannot be outlined. Use the Break and Move tool to
create a point on a circle.

* The image or word has open paths that need to be closed. Select your object, use the Show Open
Path tool. This will show a circle around the open paths. Use the Join Two Points tool to close the
open paths by dragging a box around the two paths that need to be joined. The area highlighted by the
circle. Once your open paths have been closed try outlining again.

*  Your outline choice is too large for the image size.

Separating the Outline From the Word or Image
1 With an outlined word or image displayed on your screen, right-click on the image.
2 On the displayed menu, click Color Selection.

3 Click any line in the color of the outline. When you do, all lines of that color are selected,
and you can move them to another location on the page.
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Distorting Words Into Different Shapes

The Distortion tool lets you change text or objects into crazy shapes!
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Figure 131

1 Write a word or open an image, and then use the Select Elements tool to select it.
2  On the Tools menu, click Distortion. When you do, the Distortion box opens.
3 Select the type of distortion:

e Select Freehand to move the image yourself. Use the arrow tool to move points or lines. You
can select 4 or 8 points (see step 5).

e  Select Use Form to choose a pre-designed image distortion available in the top window.
Scroll up and down to see the many shapes available.

4 Select a Work option:

* Keep lines is best used for shapes composed of only straight lines. Straight lines cannot be
manipulated.

*  Convert line to curve is used to add distortion to straight lines is possible. Use Convert line to
curve if the drawing has curves.

5 Select the number of points you wish to move, either 4 or 8.

6 Click Apply to apply your selections to the text or object.

_"'_ TIP: Try the distortion tool with the images too!

Creative Cutter MINI 89



Chapter 5 Manipulating Letters and Shapes

20

Creating Curved Titles and Words

Use the Fit Text to Path option on the Text menu to create text that curves under or over an arc.

:@@@E@y
TN

Figure 132

1 Write a word.

2 From the Draw menu, click Arc, Oval, or Circle.
3 Draw the shape you want.

*  To draw an arc, click Are and then click (do not drag) at two different spots on the page. An
arc appears between the areas where you clicked. If the arc is upside down, use the Select
Elements tool to flip it over. Then, use the Select Elements tool to adjust the size and depth of the
curve.

* Be sure the arc is bigger than the word.

4 Using the Select Elements tool, drag a square around both the word and the arc. (If you
prefer, use Select All under the Tools menu.)

5 From the Text menu, click Fit Text to Path.

6 In the Write Text on...box, select the location on the arc where you want to write the text:
top, bottom, left, or right. See figure 133 and figure 134.
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Figure 133 Example of text curved to the top
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Figure 134 Example of text curved to right

7 Click Apply to save your selections.

_‘*: TIP: To separate the line from the word, click Break text on the Write Text on... box. This
3N allows you to delete the line so the word stands alone.
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Spelling Words Vertically

This section provides two techniques for writing a word with its letters stacked vertically above
the each other.

Using the Center Technique to Spell Words Vertically

Mumber format
Move text ¥ % i ¥ it | 3
Copy text A

Mirror text : . : : : . .
Corwert text o path

Clear text transformation
Rotate text

Text specification
Text spacing : : : &

Break Text 4

Align left
Align right

Center

Wisual text spacing

Find font

Figure 135

1 Type the word letter-by-letter in the font you prefer. Press the enTER key after typing each
letter to move the cursor down to the next line.

2 Use the Select Elements tool to select the word.

3 From the Text menu, click Center. When you do, the letters in the word line up underneath
each other.
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Using the Break Text Technique to Spell Words Vertically

This technique is preferable when you have mixed upper- and lower-case letters. These letters
often are not spaced evenly when typed vertically.

=1

mToo\s Bitmap Shape Setting Window Help
Dictionary J SVIES
Font. cul+r
: NN N
Write text
Text ediion it OO N B DO DO RO { OO S DO B |

Number format

Lok

Break Text

Algn et
Aignight

Center

Visuial text spacing

D TOT >
®—TT>
O—"TT>

O—TO>

Find fort

Figure 136

1 Type the word letter-by-letter in the font you prefer. Press the enTER key after typing each
letter to move the cursor down to the next line.

2 Use the Select Elements tool L” to select the word.

3 From the Text menu, click Break Text/Break by Character. This separates the word into
individual letters. See column 1 in figure 136.

4 Use the Draw Rectangle tool to create a small box in the size you want to apply as spacing
between the letters.

5 Position the rectangle between the first two letters. Select the letter to be moved and use the
arrow keys on your computer’s keyboard to move the letter up or down. See column 2.

6 Continue using the rectangle as a spacer to help with the positioning of the letters. See
column 3.

7 Use the Select Elements tool to select the entire word, and then drag a box around it. When
you release the mouse button, all of the letters will be selected together.

8 From the Text menu, click Center. The letters in the word line up underneath each other.
See column 4.

Joining Letters Together

This section provides two methods for joining letters: by using the Visual Text Spacing tool
with Welding and by using the Welding tool to weld a bar to the bottom of a word.

Using Visual Text Spacing to Join Letters

1 Type a word in the font of your choice and then select it.

2 On the Text menu, click Visual Text Spacing. Visual Text Spacing places a little box
under each letter and an arrow pointing to the right under the word. See figure 137.
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3 Move letters to overlap, using the arrow tool or the little boxes.

_‘6' TIP: 1f you must lengthen parts of the letters to get the proper spacing, see “How to Lengthen
a5 Letters” on page 95.

Visual Text Spacing Tool

lo# o |1 |5

Space
Caractere Line jump

A I

le

|

i |

=]

Use individual Box ‘;handlee

Q
QY
©
@

= to adjust overlap of letters
=
Click arrow with mouse and while
holding mouse button, slide the
arrow to the left to move
letters until they overlap.
Figure 137

4 Use the Select Elements tool to select the word.

5 On the Tools menu, click Welding. When you do, the letters should join. If the letters do
not join, click Undo, move them slightly, and try again.
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S TIP: You can fix distortions after welding by using the Move Point tool. See “Tips for Fixing
3B Welding Problems” on page 97.

Visual Text Spacing Tool

B b " kit e e
NEEROLES p 37251 @ Al i [Weorpan
‘_—3 Deselect al col4 i 2 3 7 5
X Once the letters CEPE—— =
are overlapped, Erase S

| Use the Select Measure

Elements tool Magic Ruler™ Plus and Pro Versions »
to select the Show the color code

1 entire word. Transform »
1 ) Manipulate »
Zoom »
Cirde »
Sortinine path before outine

Sort filing order

Dimension-line »
Distorbon Ctri+K

Outiine

Shadow

Gradient
Weldng ) Then select Welding

under Tools. menu.

B2 |s/@ls 2 |2 [=m v [ao|d|w]|-

Rotaton (30)

Letters welded

Figure 138

How to Lengthen Letters

* Ifyou need to lengthen letters to obtain proper overlap, use the Move Point tool to lengthen them.
For best results, weld first and then lengthen the letters. After lengthening the letters, weld the newly
overlapped letters.

*  Create small rectangles to create a bridge between letters and weld together.

* If the letters have inside parts (such as an e or a B), be careful to select only the outside of the letter
while welding. Click on the outside line of a letter, hold down the suzrT key, and then click on the
outside line of the second letter. Then, continue to weld.
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Using the Welding Tool to Join Letters With a Bar

(5]

Figure 139

1 Type a word in the font of your choice.

2 From the Draw menu, click Rectangle to draw a rectangle bar.

3 Use the Select Elements tool to move the bar so that it overlaps word.

4 Use the Select Elements tool to select the bar and letters together. To do so, click Select All
under the Tools menu or use the Select Elements tool to drag a box around all the elements.

5 On the Tools menu, click Welding.

6 Smooth out rough lines. by using the Move Point tool or by using the Replace By Segment
tool.

TIP: 1If some letters distort during welding, break text by character and try to weld those letters
last.
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Welding Images and Words Together

Use the following procedure to weld an image and word together, as shown in figure 140.
1 Move the word and images together so that they overlap.

2 Select both objects by dragging a box around both of them.

3 On the Tools menu, click Welding.

Figure 140

Tips for Fixing Welding Problems

e If parts of words or objects disappear, select only the outlines of each object. To select the outline,
click on the first object while holding down the serFT key, and then click on the next object.

» If objects do not weld, make sure the objects are overlapping and check for open paths.

Using Drawing Tools to Change Letters and Images

You can modify the appearance of letters and images by using Pazzles Creative Cutter drawing
tools. Use the tips that follow.

Tips for Using Drawing Tools

*  When manipulating images, click and hold down the mouse button.
* To see the image more clearly, use the Zoom tool to enlarge it.

* If cutting or erasing a particular area is difficult, move that part of the image to the front. To do so,
go to the Shape menu and click Order.
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Move Point Tool

The Move Point tool allows you to select a construction point on an element and then to move
it in, out, up, or down. This is very helpful when smoothing out any imperfections in your

drawing.
Click on point with Click and drag on middle of
Move Point tool and a segment with Move Point
drag to change point. tool to create an arc.
-
Figure 141

* Using the Move Point tool, click on a point in the object and then drag it.
*  Click and drag the middle of a segment to create an arc. See figure 141.

* To display all joints and points, use the Move Point tool to drag a box around the object. Viewing
all joints and points is very helpful when making precise adjustments. See figure 142.

R

VAN

Figure 142

Fixing Scanned Images With the Move Point Tool

Images that are scanned in often contain imperfections such as stray bumps. To fix this kind of
flaw, click on the flaw with the Move Point tool and push or pull it into place.
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Break and Move Tool

Use the Break and Move tool to place a break in the image line and then bend or manipulate
the line. To use it, place a point at a new location and then move the point to create a new look.
See figure 143.

L

Figure 143

Cut Path Tool

The Cut Path tool enables cutting out a segment of a line in an image. To use it, click two
places with the Cut Path tool and then use the Erase tool to remove the cut section. See
figure 144.

Figure 144

Alternatively, cut one spot and use the Move Point tool to move the ends to the location you
prefer. See figure 145.

Figure 145

Create tabs to hold a project on the paper
1 Use the Cut Path tool to snip two breaks in the cutting line.

2 With the Erase tool, remove the snipped segment.
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Join Two Points Tool

The Join Two Points tool is helpful for joining the ends of two lines. To use it, select the Join
Two Points tool and then click and drag a box around the two ends that are to be joined.

Release the mouse button to join the points.

Figure 146

Change Color Line Tool

There are several reasons to change the colors of lines and fills:

* Changing colors allows you to choose cut order by color.

*  Changing colors can make lines more visible.

* Changing the color of lines facilitates cutting different parts of the image at different pressures.
* Changing the color of lines helps to indicate the tools used for various lines,

*  Changing the fill color in an image helps you to visualize how the image will look when cut, and it
facilitates printing the image on your color printer directly from Pazzles Creative Cutter. (Changing
the fill color does not affect the way an image cuts.)

Use the following procedure to change colors in an image or letter:
1 Select the image with the Select Elements tool.

2 Click the Change Color icon to open the Color box. See figure 147.
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Figure 147
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3 Click the mouse on a color square.
* To change the line color, click the right button on your mouse.
* To change the fill color, click the left button on your mouse.
* To lighten or darken a color, move the color bars up and down.
4 To remove fill color, click the X under the B box on the Color box.
;*'_ TIP:
= e The B column applies fill color with a brush.

e The P column applies outline color with a pen.

Creating Words Inside a Rectangle

You can manipulate the letters in words that are enclosed in a rectangle so that they are either
separated or attached.

Creating a Word with Separated Letters

1 Type a word.
2 From the Draw menu, click Rectangle.
3 Draw a rectangle under the word.

4 Weld the word and the rectangle together. See “Welding Images and Words Together” on
page 97.

5 Use the Move Point tool to drag the bottom-left corner of the bar over the top of the word.

6 Use the Move Point tool to drag the bottom-right corner over the top of the word. The word
will cut from the cardstock, as shown in the final image in figure 148.
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KAYILA

Figure 148

Creating a Word With Attached Letters

1
2
3
4

Type a word.
From the Draw menu, click Rectangle.
Draw a rectangle under the word.

Duplicate the rectangle (use aLT + D) and use the arrow key to move the new rectangle

straight above the word. See figure 149.

5

Select both rectangles and the word and weld them together. See “Welding Images and

Words Together” on page 97.

6
7
8

Use the Eraser tool to erase unnecessary parts of the rectangles.
Join the ends of the bottom and top to create sides.

Draw a rectangle around the completed word.
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6 Working With Graphics

Achieving the pages you’re dreaming of sometimes means creating, scanning, or importing
graphics. This chapter provides background information on computer graphics and tips and
techniques for creating graphics that cut and display well. We recommend that you complete
the practice project to gain experience with converting graphics (see “Practice Project:
Converting and Vectorizing a Bitmap File” on page 110).

Introduction: Pixels, Resolution, Vectors, Oh My!

Most computer graphic programs create objects with tiny dots called pixels. The number of
pixels per inch, which is also referred to as dots per inch (dpi) is called the object’s resolution.
The higher the resolution, the more dots per inch. And, the higher the resolution, the more
detail in the graphic. To see the difference between an image created at 72 dpi and 300 dpi, see
figure 150.

Figure 150

Cutting the hundreds of dots that compose an image would be cumbersome and time-
consuming. Therefore, you must convert the image from pixels to vectors, which are lines and
curves. This process can be done with the Pazzles Creative Cutter software, which essentially
connects the dots for you. The closer the dots are to each other (and therefore, the higher the
resolution), the smoother the cutting lines and curves.
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Manipulating, Scanning, and Importing Graphics

Scanning a Picture or Drawing into Pazzles Creative Cutter

1 Draw your design, preferably in black ink that is not too fine. It is helpful to draw it large;
you can scale it down later on.

2 Place the image on the scanner bed. It is best if you scan one image at a time. If you want
multiples of your drawing you can create copies within the program.

3 From the Pazzles Creative Cutter File menu, click Select Source. Your scanner model
should appear in the pop up window. (If not, make sure your scanner is hooked up to the
computer and turned on.) You may need to restart your computer with the scanner turned on.

4 Choose your scanner and click Select.

5 To scan, click Acquire. Be sure that the scanner properties are set to scan your project as a
Black and White bitmap at a resolution of 250 dpi or higher.

6 Activate the scan. Your project should appear in Pazzles Creative Cutter. When it does, use
the procedure “Importing and Vectorizing a Word or Graphic” on page 106 to vectorize it.

Importing an Image or Word Created in CorelDraw or Adobe
lllustrator

If you have created the design in Adobe Illustrator or CorelDraw, save it as an Adobe Illustrator
6.0 (Al) file and import into the cutting program. Be sure to convert text to lines, using vector
as the conversion mode. You will not need to vectorize the image in Pazzles Creative Cutter.

NOTE: This type of file sometimes results in doubled-up or duplicate lines.

Converting and Vectorizing Graphics

106

The best graphics for vectorizing are solid (filled in) and saved in black and white bitmap (bmp)
format at 250 dpi or higher). Refer to the sections that follow to automatically vectorize images.

Importing and Vectorizing a Word or Graphic

1 Save the image as a black and white bitmap (.bmp) file at a resolution of 250 or higher.
Lower resolution will yield unsatisfactory results. See “Converting an Image to Black and
White Before Saving as a Bitmap” on page 110.

2 Open a blank page in Pazzles Creative Cutter.
3 From the File menu, click Import and then select Image.

4 In the File Import box, browse to the location where the file is saved, select it, and click
OK.

5 With the image still on the screen, open the Pazzles Creative Cutter Bitmap menu.
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6 On the Bitmap menu, click Vectorization and Automatic Vectorization. See figure 151.

ols Bifmap Shape Setting Window Help

é Convert to image
See on screen Alt+E
' '
. Region > .
Change resolution
Color configuration > Edition
Special effects »
Path Tolerance
Rotate image » [ n
Italic image Italic o
Figure 151
:*: TIP: For detailed information on vectorizing, see “Tutorial 3: Prepare, Scan, and Convert a
a5 Basic Line Graph to Cutting Format” on page 58.

7 Click the image to start converting it to a vector image. Vectorizing can take a few minutes.
When the image is converted, the new image appears in yellow next to the original.

8 Use the Select Elements tool to select the original black and white image, and then delete
it.

9 Delete the outside square and any extra lines around the converted vector image.

10 Use the Select Elements tool to drag a square around the converted vector image and then
move it to the appropriate location on the page.

_‘*'_ TIP: You might want to the change the line color to make the image more visible.

Tools and Tips for Cleaning Up Vectorized Images

Depending on the quality of the original image, you may have less than perfect lines after
vectorizing. Use the tips that follow to fix problem areas.

Replace a Line

Use the Replace by a Segment tool ’LI to replace the line. Click and drag a line over the
problem area to replace it with a smooth line.

Replace a Rough Curved Area

Use the Replace by an Arc tool | i to replace the rough curved area. Click at the start and at
the end of the curve. (See figure 152.) You might need to use the Move Points tool to move the
arc into place.
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108

Cut Away Points or Bad Areas

Use the Cut Straight Line tool ¥ | to cut away points or bad areas. Drag the tool the separate
the unwanted area. See figure 153.
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Figure 152

Figure 153

Smooth a Selected Area

Use the Simply Path option from the Shape menu to smooth a selected area. Click the area
several times to remove extra points.

Convert an Uneven Circle

Use the Convert to Circle tool | 30 | (double click the Oval tool) to convert an uneven circle
to a perfectly shaped circle.

Straighten a Crooked Line

Use the Horizontal/Vertical tool f_..l to straighten a crooked line horizontally or vertically.

Eliminate Stray Lines

Use the Move Point and Eraser tools to eliminate stray lines. If stray lines appear in scanned
drawings, they might be caused by stray dots in the scan, either from flaws in paper or dust on
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the scanner. The program is trying to “connect the dots” for you. Use the Move Point tool to
drag the end of the line outside of the image and then click the Erase tool to remove them.

Remove Extra Lines

To remove the extra lines, select the lines and press the bELETE key on your keyboard. If the
lines are difficult to remove, use the Erase tool to remove two or three pieces of the unwanted
line and then select and delete the broken sections.

Avoid Double Lines

Convert the image to a solid graphic to avoid those pesky double lines. To do so, color the
image by hand (solidly!) or use a graphics program to fill in before vectorizing.

Fixing Vectorizing in Scanned Drawings or Photographs

If you encounter problems when trying to vectorize a scanned drawing or photograph (not an
outline or solid), convert images to an outline or solid image. To do so, first outline it by hand
with a black pen. Then, scan at 200 dpi in black and white, or use a “paint” or graphics program
to fill the image in and make it solid. Save the image as a black and white bitmap (bmp) file,
vectorize, and remove any double lines after vectorizing. Alternatively, use the hand-
vectorizing method described on page 110.

Converting Low-Resolution Images

Some publishing programs (such as MS® Publisher, Printshop, and Printmaster) feature
program-specific file formats. Images created in these programs often are low resolution, and
you may not be able to save them in bitmap format. To remedy the issue, print the image in
BEST quality, trace it, and then scan it in as a black and white bitmap. See “Manipulating,
Scanning, and Importing Graphics” on page 106. Alternatively, use the hand-vectoring method
on page 110.

Creative Cutter MINI 109



Chapter 6 Working With Graphics

Converting an Image to Black and White Before Saving as a
Bitmap

If you receive a message during vectorizing that you are using the wrong file format or if
nothing happens when you start to vectorize an image, the image was not saved in black and
white bitmap (bmp) format. Use this procedure to fix the problem.

NOTE: This procedure will not work if your image is in Index format.

1 From the Bitmap menu, click Change Resolution.
2 Click on the image. When you do, the Bitmap Resolution box opens.

3 Working step by step, change the Bits per pixel and Dithering method selections from the
current settings down to 1 bit per pixel and Dithering method None. Do not go directly from the
current setting to 1 bit per pixel and Dithering none; you must proceed through each option.

4 Proceed with vectorization. See “Importing and Vectorizing a Word or Graphic” on
page 106.

Practice Project: Converting and Vectorizing a Bitmap File

1 From the File menu, click Import and then click Image.
2 Locate and open Sample Bitmap 2 on the Creative Cutter CD.

3 On the Pazzles Creative Cutter Bitmap menu, click Vectorization and Automatic
Vectorization.

4 Click on your scanned image. When you do, the program begins to convert it to a vector
image. This process can take a few minutes, especially if the image is detailed.

5 When the vectorizing process is complete, the new image appears in yellow next to the
original. (To change the color, see “Step 1: Prepare the Image and the Tools” on page 111.) You
can delete the box if you wish.

6 Click the Select Elements tool, click on the black bitmap image, and click pELETE to
remove it.

7 To view the vectorized image more clearly, click the View Page tool and click on the
screen. Then, use the Select Elements tool to drag a square around the image and move it onto
the page, if necessary. Use the View Page tool to enlarge the page for better viewing.

Hand-Vectorizing An Image

110

You can convert any drawing, graphic, or photograph to a cutting file by hand vectorization. In
simple terms, hand vectorizing involves using some basic drawing tools to trace around the
image. You might find that this becomes your preferred method of converting graphics!

For more detailed information and instructions, see ‘“Tutorial #4: Hand Vectorizing a Graphic or
Photo” on page 69.
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Step 1: Prepare the Image and the Tools

1 Scan a photo or graphic into Pazzles Creative Cutter or open a graphic that is already saved
on your computer. See figure 154.
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Figure 154

2 Resize the graphic to fill the screen. Using the Select Elements tool, click one of the
image’s corner handles. While holding down the mouse button, drag the picture to a larger size.

3 Double click the Segment tool (located on the left side of the workspace) to open the
Segment toolbar. You will use the first two tools on the toolbar.

SREeE

Figure 155

4 Set the line thickness by clicking the Pen and Brush tool to open the Pen window. Change
the Pen width to 0.04 or 0.05 and click Apply.

5 Set the line color by clicking the Color Palette icon to open the Color window. Right click
on the color of your choice.

Step 2: Trace the Image

1 Use the Magnify tool to enlarge a section of the picture.

2 Click the Segment from Path tool.
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3 Click on a starting point and then hold the mouse button down as you drag the starting line.
See figure 156.
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Figure 156

4 Continue tracing the image by clicking on a spot some distance away from your first line.
As you click along the outline of the image, a line will fill in between the point.

5 Click the Redraw tool. When you do, the line colors changes to red. See figure 158.

6 Continue tracing around the picture until you reach the starting point. The beginning and
ending points should connect automatically.
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Step 3: Shape the Lines to Fit the Image

1 Click the Move Point tool and begin to shape the lines to fit the image. See figure 157.
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Figure 157

* Toround a line, click the middle of a segment.

* Toresize a segment or to create a point, click on an end point of a segment.
2 Shape the lines all the way around the outline as needed.

3 Use the Segment from Path tool to outline other features. Keep in mind that when using
the Segment from Path tool, the end of a line must connect with the beginning point.
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4 Use the Draw Segment tool to add individual accent lines. Accent lines do not connect the
the line made previously. See figure 158.
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Figure 158
5 Use the Move Point tool to shape the accent lines.

6 Use the Join Two Points tool to connect the ends of lines. To do so, click and hold down
the mouse button while dragging a box around the end points that need to be joined. When you
release the mouse button, the ends should join.

7 Select the image (picture) portion of the screen and delete it. The newly created cutting
image remains on the screen.

8 Fix any open paths. First, use the Show Open Paths tool to find unconnected end points.
Next, use the Join Two Points tool to drag a small box around the points to connect the ends.
See figure 159.
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Figure 159
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Tracking Customer Data

Use the Customer option on the Edit menu to keep records of your customers’names, prices
charged, and fonts and images.

Customer- Edit Menu

Use this to keep records of customer names, prices
charged, and fonts or images used.

Information

Customer

Contact : |

Startdate: |10/03/2005
Tel:l Facs I I
Completronli
E-mail : | Ston

Location

Address | Delver  [oo-00-0000
City: I Country : I Transpon:l

Zip/Postal Code:
Terms : |

Price : |0.000000
Advert Font- large letters

Tekton Font- small letters

Image- Butterfly from CD#1 Print

Name : IName of customer who ordered project

Comments:

Figure 160
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7 Specialized Cutting and
Finishing Techniques

This chapter provides tips and techniques for specialized cutting requirements, including
cutting on unusually sized papers, cutting on media other than paper, and applying special
effects such as embossing during cutting.

Tips for Cutting Unusual Media and Sizes

A WARNING! When you are working with unfamiliar or heavy materials, do not leave the cutter
unattended. If the cutter gets stuck in your absence, the motor could burn up. This type of
mishap is not a warranted repair. For tips on cutting a wide variety of materials, please refer to
the cutting pressure guide that was included with the sample paper pack. Please contact Pazzles
if you need a cutting pressure guide.

T f
ype o Notes
material
Vellum Be sure it is well adhered to the mat. Cut @ 100-120 pressure or use the
pen tool to emboss this material.
Thin Magnetic Use simple designs. Use 115-125 pressure extend blade out slightly.
sheets
Transparency Be sure it is well adhered. Use 100-120 pressure.
plastic

Thin metal foil Use an old blade and high pressure. Extend blade out slightly, use 100-
110 pressure.

Metallic papers Increase pressure. You may need to cut two or three times.

Printable canvas Make sure it is well adhered to mat. Use 135-165 pressure.
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Special Techniques for Cutting

Moving Objects From the Front or Back When Working With
Lines

Objects are placed on the page in layers that can be rearranged for easier manipulation. Use the
Move to Back/Move to Front tool to manipulate the image on your screen. See figure 161.

Figure 161

Sorting the Inline Path Before Cutting

Use this procedure to prevent a letter or object from popping out of the paper during cutting.

1 Use the Select Elements tool to select the object. Be sure that all parts of the object are
selected.

2 On the Tools menu, click Sort inline path before outline.

118 Creative Cutter MINI



Chapter 7 Specialized Cutting and Finishing Techniques

Troubleshooting Problems With Inline Cutting

If a program error appears and the program shuts down while completing this procedure:

*  You might have circles and ovals in the project. Create extra points with the Break and Move
tool.

*  You might have open paths. Use the Show Open Paths tool to find them. Use the Join Two
Points tool to close them.

Cutting a Project More Than Once

If your project uses heavy paper or other materials, you might need to cut two or three times.
Do remove the mat from the cutter after the first cut!

To make cut multiple times, use one of the following methods:

Method 1: Press Start on the cutter control panel. Be sure Advance is not checked in the
Cutting Control Panel.

Method 2: Press Start.

IMPORTANT: 1tis essential that the Advance box is NOT checked and that you do NOT move
the mat!

=
=

Creating Stencil Cuts

You can make any font into a stencil cut. See figure 162.
Q
D D | \)

1 Type a word and select Convert Text to Path from the Text menu.

Figure 162
Click the Cut Straight Line tool and use it to cut away sections of letters.

2
3 Drag and draw two lines across the section you want to remove.
4

Remove unnecessary pieces by selecting the sections and deleting them. See figure 163.

OOOPD
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Figure 163

Scoring Paper

If you want to score part of the project and cut another, as you would for an envelope, use the
following guidelines:

* Complete the process in two separate steps.

*  Be sure to change the color of the scored part of the project. (See “Change Color Line Tool” on
page 100.)

Scoring and Then Cutting an Image

IMPORTANT: Do not move the mat between steps.

1 Select the color for scoring.

2 Reduce the pressure setting to a light pressure. See figure 164.
3 Click Start.

4 Select the color for cutting and increase the pressure.

5

Click Start.

TN Pare: 12 I Miror [ Sendtofle [~ Selected cbiect Start

3 ™ Rotate ™ Advance

= TS 30 eeding [T Weedal  @l@l@] 7] _fieum
tiars Al colors «| W 5> | Vi Size [209 x 896 Stop cutting

Figure 164

TIP: You can also use the KissCut function to create scoring. See “Converting Lines to Stitch
Marks” on page 122.
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Cutting Round Corners

1 Draw a rectangle on the page.
2 Click the Round Corner tool.

3 In the Radius box, assign a value to apply to the corner and then click OK. To change this
value later, double-click on the computer screen. See figure 165.

Figure 165

_‘*'_ TIP: If you choose too large a radius, or a tiny segment is near the corner, you will get an error
3 - message.

4 Click the Round Corner tool on the corner you want to round. See figure 166.

SR

Figure 166
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Cutting Around Tight Corners

To get clean cuts with fonts that have tight corners and angles, use the tips that follow.

¢ Use the Break and Move tool create a new break in the line.

e Use the Move Point tool to move the point away from the break. Doing so creates curves instead
of points. The curve is imperceptible to the eye but greatly eases cutting. See figure 167 and

figure 168.

@
L

B @ |s £ll=|M|rofofefRl /N )7

<

Figure 167

Click the Break and

Move Tool here. This

J—

Figure 168

creates a new break (or

point) n the line.

You now have 2 points.
One at the corner and the

new one just created.

Creating Stitch Marks

f Y\ | ]
/ Innet angles rounded t’z'; cut qmoothen
/ \ 4 / /

You can convert lines to stitch marks. Two lengths of stitch marks are available: KissCutl and

KissCut2.

Converting Lines to Stitch Marks

1 Click the Pencil tool on the left toolbar to open the Pen/Brush window. See figure 169.

2 In your image, select the line to convert.

» To apply kiss cuts to ovals and circles, use the Break and Move tool to create more points.

Then, click on the line at four equally spaced spots.

* To apply kiss cuts to text, first apply Convert Text to Path from the Text menu to the text.
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3 In the Pen/Brush window, select KissCutl or KissCut2 and then click Apply.

:6'_ TIP: Remember to change back to a solid line before you type or draw. If you don’t, your lines

2 will continue to be KissCut style.
YR e e
ZEZ'ZZZZZ'ZZ'ZZZZZ'ZIZZZZZ Joints—| | Extremity
. E . o G “W | ca
e . i W cm
HESIERINRAY (- || -
i i e 0 widh
et

- Feset Apply
Figure 169

Cutting With the Creative Cutter Pen Tool

The Creative Cutter pen tool is designed to work with Sakura Gelly Roll pens.

Step 1:Insert the Pen Into the Holder and Into the Cutter

1 To insert the pen into holder, loosen the white thumbscrew and push a Sakura Gelly pen all
the way in. Note that some pens are slightly thicker than others but become easier to insert over
time. If the pen is difficult to insert, try rubbing it with sandpaper to to allow it to insert into the
pen tool.

2 Insert the pen holder into the carriage of the Creative Cutter, using the same opening as for
the bladeholder.

3 Verify that the lip of the pen holder is seated flush to the opening.

4 Tighten the white thumbscrew to secure the pen holder in place.

IMPORTANT: Do not overtighten the thumbscrew.

=
=

NOTE: These same steps can be used with the marker tool as well.

Step 2: Using the Pen

1 Open any of the Creative Cutter images or create your design in Pazzles Creative Cutter.
Because you are not cutting paper, you can choose images that have intersecting lines.

2 Place paper on the cutting mat and insert it into the cutter.

3 Open Cutting panel in Pazzles Creative Cutter and set the pressure to approximately 100.
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4 Set the speed at Draw.

5 Click Start to begin drawing. If the pen drags lines, try decreasing the pressure.

Creating a Drawing With Multiple Colors

1 Create the design in Pazzles Creative Cutter or use one of the Creative Cutter images.

2 Add an outline. Be sure to assign a different color to the outline that you will use for
cutting.

3 Change the colors of detail lines to correspond to various pen colors.
4 Insert a pen into the pen holder.

5 In the Cutting Control Panel, click the box with the color that corresponds to the pen color.
The screen display changes to show only lines of that color.

6 Verify that the Advance box is clear (not checked).
7 Set the pressure to 100.
8 C(Click Start.

Change the Pen Color and Cut

1 When the first color drawing is finished, do not remove the mat from the cutter. Remove the
pen by loosening the white thumbscrew on the pen tool itself.

2 Insert the next pen and repeat steps 5-8. Continue the same process for all colors.

3 When all color drawing is finished, do not remove the mat from the cutter. Remove the pen
holder and insert the cutting blade.

4 Cut the image: First, click on the box with color for outline to display only cutting lines.
Reset the pressure, and then click Start.

Cutting control panel

Gl ’._P""" aei: 2 Mo T Sckcledobiest [ Sendlofie

Rotate. I Advance
pam Pressue: [300 Vosds I ot URIE 1 Aewn |
7 > Lerghs Hogh
Options Al colors. « o> | Vit Sice [2% « 903 Stop culling

Rl |2 |2 | v o]oc|ul/]H |

Figure 170
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8 Troubleshooting Guide

This chapter provides information on solving problems that have been encountered by some
Creative Cutter users. Please consult this chapter before calling Support.

Troubleshooting Tips

Issue Possible Causes and Remedies

You want to work in Pazzles Open another Pazzles Creative Cutter. You can cut and paste between

Creative Cutter while cutting the two.

You want to stop cutting If you close the Cutting Control Panel, you may stop the cutting
process. Please either push stop cutting or turn off the machine for 1
(one) minute and turn back on to reset the machine.
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Issue

Possible Causes and Remedies

How to uninstall and reinstall the
program

Step 1: Note and record the current port settings. Click SETTINGS and
then click Plotter Codes.

Step 2: Remove all Pazzles Creative Cutter registry files

If you have saved any file within the Pazzles Creative Cutter program
in the Image folder, save them in another location before beginning
this procedure!

1. Point to Start at the bottom-left corner of you computer screen, and
click All Programs.

2. Click Pazzles Creative Cutter, click Tools, and then click Pazzles
Creative Cutter Registry.

3. In the box that appears, select and delete all registry files.

Step 3: Unistall the Pazzles Creative Cutter program

1. Open your Control Panel on your computer, then go to Add/
Remove programs.

2. Click Pazzles Creative Cutter Creative Cutter 2005, and then
click the remove button to the right of it.

Step 4: Delete the Signmax and Pazzles Creative Cutter folders

1. Point to Start and then click My Computer.

2. Select the C: drive and click the folder named Program files. (If
you get a message about hidden folders, select to see hidden
folders).

3. In the Program Files folder look for a Signmax folder and delete
1t.

Step 5: Search and delete other files

1. Close all windows until you return to your Desktop screen. Then,
point to Start and click Search.

2. Select to search all files, type Pazzles Creative Cutter in the box,

and click Search.

Delete any files found.

4. Repeat the search process, typing Signmax in the box. The only
folder you should see is the Signmax folder in the Recycle Bin.

98]

Step 6: Reinstall the program

1. Use the directions in Chapter 2.

2. After installing, re-check the registry files. Delete any you find

3. Restart the computer. The registry files will rebuild.

4. In Pazzles Creative Cutter, set up the driver and port. See Chapter
2.
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Issue

Possible Causes and Remedies

The program aborts or generates a
run-time error

Generally there are a few very common reasons for a runtime error. All
of these are easily avoidable once you know what they are.

Issue: You are using software version Letter 14.0 and are trying to
open files for version 2005.

Solution: Make sure you open the cutting file folder that says 12.0 or
14.0.

Issue: You are using software version Letter 2005 and are trying to
open files created in an older version of the program.

Solution: If your files are not in a folder marked _05, they are in the
old version. You must import those files into the 2005 version.

Issue: You are trying to outline and you choose multiple outlines.

Solution: Three is the maximum safe number of outlines. After three,
click on the outermost outline and do the outline function again.

Issue: You are trying to outline and you have chosen TOO large of an
outline.

Solution: Reduce the size of the outline.

Issue: The memory in your computer is full. The program tries to
remember every move you make so that you can use the Un-Do
function.

Solution: Clean the memory by going to HELP and choosing Clean
Memory, OR go to the Setting menu and select SET UP. On the
Document page, click Undo and change the number of saved steps to
10 or fewer.

Issue: Errors occur when you have open paths. These are points next to
each other that should be joined.

Solution: Use the Show Open Paths tool to find the problem. It
appears on the bottom of the toolbar on the right side of the screen. It
has a question mark beside a line with two dots. Then close the open
paths with the Join two points tool. See “Break and Move Tool” on
page 99 and “Join Two Points Tool” on page 100.

Creative Cutter MINI

129



Chapter 8 Troubleshooting Guide

Issue

Possible Causes and Remedies

The program aborts or generates a
run-time error

Issue: You are using the Sort Inline before Outline function.

Solution: Check to see if you have circles or ovals made with the Draw
tool. These objects have no beginning or end point. Apparently, this
confuses the program! See “Break and Move Tool” on page 99. Create
some points on them by using the Break and Move tool. See “Break
and Move Tool” on page 99.

Issue: You have too many programs running in the background. They
are all using memory to one degree or another. There is not enough
memory to execute a function and you can get a runtime error.

Solution: Close background programs that are not necessary.
Especially check the icons in the lower-right corner of your desktop
screen. These tray icons mean that the program is running at least
minimally in the background. Usually you can right click on the icon
and bring up a menu that will allow you to shut them off. Common
ones that seem to be default with Windows are QuickTime, AOL,
Outlook Express, and some scanners and printers.

Start and stop points do not meet

Decrease pressure.

Check the cutting mat. It might be warped or in need of cleaning.
Remove small bits of lint from the mat.

Move the cutting start point (use the Shape menu).

Projects do not cut completely

Pressure is too weak: increase it. DO NOT BE AFRAID TO
INCREASE THE PRESSURE TO 245+! However if you go above 245,
the pressure will ultimately be O (zero)

The mat is drooping due to paper weight or humidity. Place a small box
directly behind the cutter to keep the mat flat or use our Creative Cutter
platforms.

Cutting project is outside of allowable margins. Move it or check page
settings.

The paper buckles

The pressure is too high. Reduce it.
The cutting speed is too high. Reduce it.
The cutting mat needs more adhesive.

Paper or material is hard to hold. See mat instructions for pinch roller
placement.

Cutting project is distorted

Usually this happens only at the edge of paper at the back of the cutter.
This kind of error means the paper is buckling or that the project is just
outside the allowable margin. Also check to see that the mat is not
bumping something near the cutter as it moves back and forth.
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Issue

Possible Causes and Remedies

Sharp angles do not cut well

Reduce the cutting speed.

Reduce the pressure. Setting the pressure too high pushes in the
corners instead of cutting them.

Round the corner: use the Break and Move tool to change the point into
a curve. See “Break and Move Tool” on page 99 and “Cutting Around
Tight Corners” on page 122.

When cutting an object inside of
another shape the shape pops out
and gets caught on the cutting
blade

You need to change the cutting order so that the smaller inside piece is
cut first.

1. Select the object or project with Select Elements tool. Be sure to
select all parts by dragging box around object or by choosing
Select All under Tools menu.

2. On the Tools menu, click Sort Inline path before Outline under
Tools menu.

You want to position the paper so
that it will cut in the same place
each time

Be sure that the box by Advance in the Cutting Control Panel is NOT
checked!

Be sure you place the rollers on the same part of the mat each time, to
help you learn where the machine cuts.

You’ve lost changes to a project

Save, save, save! Saving a project in Pazzles Creative Cutter is as
simple as saving in any other Windows-based program. Select Save or
Save As under the File menu (or press CTRLA4S). Create an appropriate
folder for your projects (usually in My Documents), give your project a
name, and click Save. Save often!

You want to cut over the same
lines because the lines did not cut
clearly.

*  Press the Start button on the Cutting Control Panel. Do not remove the
mat from the cutter and verify that Advance is not checked in the Cutting
Control Panel.

Vectorized drawings have stray
lines, double lines, or just look
like a mess

Use the procedures in “Tools and Tips for Cleaning Up Vectorized
Images” on page 107.

You want to save a project you
have created

DO NOT save files in an Images folder within the cutting program!

Save all files in MY DOCUMENTS. This will prevent any loss of files
if you need to reinstall the program.

To save: Go to File, Save As, Save In: My Documents/Your Folder

Creative Cutter MINI
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